User's Manual
Advanced
This manual supports the following models:

How to read this manual
Symbols
The following symbols are used in this manual.
B840dn  B840
B820n  B820
Multipurpose tray  MPT, MP tray
Second tray unit  tray 2
Third tray unit  tray 3
PostScript3 Emulation  PSE, POSTSCRIPT3 EMULATION, POSTSCRIPT3
EMULATION
®
®
•• Microsoft Windows 8.1 64 - bit Edition operating system  Windows 8.1
(64bit version)*
®
®
•• Microsoft Windows 8 64 - bit Edition operating system  Windows 8
(64bit version)*
®
®
•• Microsoft Windows Server 2012 64 - bit Edition operating system 
Windows Server 2012 (64bit version)*
®
®
•• Microsoft Windows Server 2012 R2 64 - bit Edition operating system 
Windows Server 2012 R2 (64bit version)*
®
®
•• Microsoft Windows 7 64 - bit Edition operating system  Windows 7 (64bit
version)*
®
•• Microsoft Windows Vista™64 - bit Edition operating system  Windows
Vista (64bit version)*
®
®
•• Microsoft Windows Server 2008 R2 64 - bit Edition operating system 
Windows Server 2008 R2*
®
®
•• Microsoft Windows Server 2008 64 - bit Edition operating system 
Windows Server 2008 (64bit version)*
®
®
•• Microsoft Windows XP x64 Edition operating system  Windows XP (x64
version)*
®
•• Microsoft Windows Server™ 2003 x64 Edition operating system 
Windows Server 2003 (x64 version) *
®
®
•• Microsoft Windows 7 operating system  Windows 7*
®
•• Microsoft Windows Vista™ operating system  Windows Vista*
®
®
•• Microsoft Windows Server 2008 operating system  Windows Server
2008*
®
®
•• Microsoft Windows XP operating system  Windows XP*
®
•• Microsoft Windows Server™ 2003 operating system  Windows Server
2003*
®
•• Windows , general name for Windows 8.1, Windows Server 2012 R2,
Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server
2008 R2, Windows Server 2008, Windows XP, Windows Server 2003 
Windows
* I f there is no special description, 64bit version is included in Windows 7,
Windows Vista, Windows Server 2008, Windows XP, and Windows Server 2003.
••
••
••
••
••
••
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Symbol
Note!

• printer work properly.

Memo

• Items that are useful to know or which are reference items for
when using the printer.

It is strongly recommended that you read these in order to avoid operating
the machine incorrectly.

Recommended to read.

The descriptions in this manual, unless particularly specified, refer to the operation procedures of B840dn . The screen or operating procedure may differ
depending on the model.
As an ENERGY STAR Program Participant, the manufacturer has
determined that this product meets the ENERGY STAR guidelines
for energy efficiency.
This product complies with the requirements of the Council
Directives 2004/108/EC (EMC), 2006/95/EC (LVD) and
2009/125/EC(EuP), as amended where applicable, on the
approximation of the laws of the
member states relating to Electromagnetic Compatibility, Low
Voltage and Energy Using Products.
The following cables were used to evaluate this product to achieve EMC directive 2004/108/EC compliance and configurations other than this may affect
that compliance.
CABLE TYPE
Power
USB

LENGTH (METRE)
1.8
5

Parallel

1.8

LAN

15

CORE

SHIELD

Caution

Regarding trademarks

This equipment uses CR2032 lithium batteries on the main control board.
The machine has a life of 10 years with normal use.
Please seal the batteries with a tape or similar material upon disposal.
Mixing with other metals or batteries may result in fires or explosions.
Please dispose of batteries in accordance with rules and regulations of
the local government.
Please do not dispose of them in a landfill site amongst already processed
garbage.

Regarding the software on the printer
This product has RSA Security Inc.'s RSA® BSAFE™
software installed on it.

B820n/B840dn has passed the IPv6 Ready Logo Phase 1
test.

OKI is a registered trademark of Oki Electric Industry Co., Ltd.
Microsoft, Windows, Windows Server and Windows Vista are either registered
trademarks or trademarks of Microsoft Corporation in the United States and in
other countries.
Apple, Macintosh, MacOS, AppleTalk, EtherTalk, LaserWriter, Bonjour and
TrueType are either registered trademarks or trademarks of Apple Inc. USA,
in the USA and in other countries.
Adobe, PostScript and Reader are either registered trademarks or trademarks
of Adobe Systems Incorporated in the USA and in other countries.
Other product names and brand names are registered trademarks or
trademarks of their proprietors.

About this manual
111 The reprinting of part or all of this manual without permission is strictly
prohibited.
222 The contents of this manual are subject to change in the future without
prior notice.
333 This manual has been created with due care, however, in the unlikely event
that you notice something that is unclear, incorrect, or omitted, please contact the store at which you purchased the product.
444 Please understand that notwithstanding point 3, Oki Data accepts no responsibility for the contents of this manual in terms of the effect on the
operation of the machine.

Regarding the copyright of this manual
All copyrights are reserved by Oki Data Corporation. This manual cannot be
reproduced, transmitted, or translated without permission. You must obtain
permission from Oki Data Corporation before doing so.

© 2011 Oki Data Corporation
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EMERGENCY FIRST AID
Take care with toner powder
If swallowed, give small amounts of cold water and seek medical attention.
DO NOT attempt to induce vomiting.
If inhaled, move the person to an open area for fresh air. Seek medical attention.
If it gets into the eyes, flush with large amounts of water for at least 15
minutes keeping eyelids open. Seek medical attention.
Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

ENVIRONMENTAL INFORMATION
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Chapter 1 P
 rinting with various kinds of paper
Print on envelope������������������������������ 10
Print on labels and Transparency��������������������� 15
Print on any kind of sized paper you want (custom page)������ 20

Note!

• In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.
• The screen or procedure may vary depending on the application you use.
• Please refer to Online Help for detailed explanations of each setting item for printer drivers and utilities.
• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.

Chapter 1 Printing with various kinds of paper

Print on envelope
1

Publication of Functions

Method of operation

Print on envelopes from the multipurpose tray (MP Tray).

Print on envelope

Note!

1

• The printing speed will be slow.
•	If printing and treating the multipurpose tray as a manual feed,
and if the time until setting the paper exceeds the manual time
out in the system configuration menu (the default value is set at
1 minute), the print data will be automatically destroyed.

Set the paper.

①① Set the paper in the multipurpose tray and align it with the left
and right manual guides.

Operating environment
Mark

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

manual guides

②② Press the set button.

Can use

set button

10

②② Open the face up stacker.

Paper set direction
Com-9, Com-10,
DL, C4, C5, C6,
Monarch

Print on envelope

2

1

face up stacker

Open the face up stacker.

③③ Open the paper supporter.
The paper will be output on the face up stacker, stacked in the
reverse order in which it was printed.
Note!

• Do not open the face up stacker during printing. This may result in a paper jam.

①① Open the rear printer side of the face up cover.
paper supporter

3

Set the paper size and paper thickness.
Here the procedure for setting COM-9 envelope is explained.

face up cover

①① Press the

or the

button several times. The [MEDIA

MENU] will be displayed, and press the

②② Press the

or the

ENTER button.

button several times. [MPT PAPER-

SIZE/A3] will be displayed. Press the

ENTER button.
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③③ Press the

or the

button, and [COM-9 ENVELOPE]

②② Select [A4] in [Size], and [Portrait] or [Landscape] in
[Orientation], and click [OK].

will be displayed.

1

④④ Press the

ENTER button, and a [*] will appear on the

Print on envelope

right side of the set value.

⑤⑤ Press the

Back button, then press the

or the

button several times. [MPT MEDIAWEIGHT/M LIGHT] will be
displayed. Press the

⑥⑥ Press the

ENTER button.

or the

button, and [HEAVY] will be dis-

played.

⑦⑦ Press the

ENTER button, and a [*] will appear on the

right side of the set value.

⑧⑧ Press the

Online button, and [ONLINE] will be displayed.

4

Open the file you want to print.

5

Select paper [Size] and [Source],then print.

③③ Select [Print] from the [File] menu.
④④ Click on [Preferences].
⑤⑤ Select [Automatically Select] in [Paper Source] in the [Paper/
Quality] tab, and click [OK].

Those using a Windows PS printer driver

①① Select [Page Setup] from the [File] menu.

⑥⑥ Click [Print] in order to print.
12

Those using a Windows PCL printer driver

⑤⑤ Select [Multi Purpose Tray] from [Source] in the [Setup] tab.

①① Select [Page Setup] from the [File] menu.

1

②② Select [Com-9] in [Size], and [Portrait] or [Landscape] in
[Orientation], and click [OK].

Print on envelope

⑥⑥ Click [OK].
⑦⑦ Click [Print] in order to print.
③③ Select [Print] from the [File] menu.
④④ Click on [Preferences].

For those using a Mac OS X

①① Select [Page Settings] from the [File] menu.
②② Select the printer model name in [Format For], [Envelope #9]
in [Paper Size], and the appropriate orientation in [Orientation],
and click [OK].
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③③ Select [Print] from the [File] menu.
④④ If you are using a PS printer driver, select [Multi-Purpose Tray]
on the [Paper Feed] panel.

1
Print on envelope

⑤⑤ If you are using a PCL printer driver, select [Multipurpose Tray]

on the [Setup] panel, select [Heavy] in [Media Weight] on the
[Setup] panel.

Memo

• If you are using a PCL printer driver, and if you are printing
with a portrait orientation (a long - type one with the flap
towards the top) on an envelope, it will be printed 180˚ the
other way.
• If you are using a PCL printer driver, and if you are printing in
a landscape orientation (a long - type one with the flap on the
right side) on an envelope, select landscape (central icon) in
[Orientation] on the Page Setup screen.
•	If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

⑥⑥ Click [Print] in order to print.
14

Print on labels and Transparency
②② Press the set button.

Publication of Functions

1

Print labels and Transparency from the multipurpose tray (MP
Tray).

Print on labels and Transparency

Note!

• The printing speed will be slow.
Orientation of Setting Paper

•	If printing and treating the multipurpose tray as a manual feed,
and if the time until setting the paper exceeds the [MANUAL TIMEOUT Out] in the [SYS CONFIG MENU] (the default value is set at
1 minute), the print data will be automatically destroyed.

ABC

set button

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer
driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

2

Open the face up stacker.

Windows

Mac OS X

The paper will be output on the face up stacker, stacked in the
reverse order in which it was printed.

PCL Printer
Driver

PCL Printer
Driver

①① Open the rear printer side of the face up cover.

Can use

Method of operation

1

Set the paper.

①① Set the paper in the multipurpose tray and align it with the left
and right manual guides.

face up cover

Mark

manual guides
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②② Open the face up stacker.

③③ Press the

or the

button, and [LABELS] will be dis-

played.

1

④④ Press the

ENTER button, and a [*] will appear on the right

Print on labels and Transparency

side of the set value.

⑤⑤ Press the

face up stacker

Back button, then press the

or the

button several times. [MPT MEDIAWEIGHT/M LIGHT] will be dis-

③③ Pull out the paper supporter.

played. Press the

⑥⑥ Press the

ENTER button.

or the

button, and [HEAVY] will be dis-

played.

⑦⑦ Press the

ENTER button, and a [*] will appear on the right

paper supporter

side of the set value.
Note!

3

Set the paper size and paper thickness.
Here the procedure for setting labels is explained.

①① Press the

button several times. The [MEDIA MENU] will

be displayed,and press the

②② Press the

or the

ENTER button.
button several times. [MPT MEDIA-

TYPE/PLAIN] will be displayed. Press the

16

⑧⑧ Press the

• Do not open the face up stacker during printing. This may result in a paper jam.

ENTER button.

Online button, and [ONLINE] will be displayed.

4

Open the file you want to print.

5

Select [Paper Size] and [Paper Feed Method] and print.

Those using a Windows PS printer driver

Those using a Windows PCL printer driver

①①Select [Page Setup] from the [File] menu.

①① Select [Page Setup] from the [File] menu.

②② Select [A4] or [Envelope] in [Size], and [Portrait] or [Landscape]

②② Select [A4] or [Envelope] in [Size], and [Portrait] or [Land-

in [Orientation], and click [OK].

scape] in [Orientation], and click [OK].

1
Print on labels and Transparency

③③ Select [Print] on the [File] menu.
④④ Click on [Preferences].
⑤⑤ Select [Multi-Purpose Tray] in [Paper Source] in the [Paper/
Quality] tab, and click [OK].

③③ Select [Print] from the [File] menu.
④④ Click on [Preferences].

⑥⑥ Click [Print] in order to print.
17

Chapter 1 Printing with various kinds of paper

⑤⑤ Select [Multi Purpose Tray] from [Source] in the [Setup] tab.

④④ Select [Multi-Purpose Tray] on the [Paper Feed] panel.

1
Print on labels and Transparency

⑤⑤ If you are using a PS driver, select [Medium-Heavy] in [Media

Type] within [Insert Option] function settings on the [Printer
Features] panel.

⑥⑥ Click [OK].
⑦⑦ Click [OK] or [Print] on the Print screen, in order to print.
For those using a Mac OS X

①① Select [Page Settings] from the [File] menu.
②② Select the printer model name in [Format For]; [A4] or [Envelope]

in [Paper Size], and the appropriate orientation in [Orientation],
and click [OK].

③③ Select [Print] from the [File] menu.
18

If you are using a PCL printer driver, select [Multipurpose Tray]
on the [Setup] panel, select [Heavy] in [Media Weight] on the
[Setup] panel.

Memo

•	If setting details are not displayed in the print dialog box for Mac OS
X 10.7 to 10.9, click [Show Details] at the bottom of the dialog box.
• If the print option is not displayed in the print dialog box for Mac
OS X 10.6.8, click the disclosure triangle next to the [Printer]
drop-down list.

1
Print on labels and Transparency

⑥⑥ Click [Print] in order to print.
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Print on any kind of sized paper you want (custom page)
1

②② Right - click on the [OKI B840(PS)] icon, and select [Printing Prefer-

Publication of Functions
You can independently set paper size and use it in the same way as normal paper size.

Print on any kind of sized paper you want (custom page)

Note!

• You must set the paper size to portrait.
•	If large sized paper does not print correctly with a PS printer driver, you
may be able to print correctly by selecting Normal in [Print Quality].
Sizes that can be set
Width
Length (Height)

Trays 1 - 3 *
148 - 297 mm
182 - 432 mm

ences].

③③ Click [Advanced] in the [Layout] tab.
④④ Select [PostScript Custom Page Size Definition] in [Paper Size].
⑤⑤ Enter [Width] and [Height].

Multipurpose tray
(MP Tray)
76 - 297 mm
148 - 432 mm

* Tray 3 is only B840dn

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows

B820n
Mac OS X

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

⑥⑥ Click on [OK].
Note!

PS Printer
Driver

PCL Printer
Driver

PS Printer
Driver

PCL Printer
Driver

Can use

• You cannot set the [Offsets Relative to Paper Feed Direction].

Those using a Windows PCL printer driver

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Method of operation

Panel] - [Devices and Printers].

Those using a Windows PS printer driver

For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Panel] - [Devices and Printers].

For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].

For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].

For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].

For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].

For Windows Server 2003, select [Start] - [Printers & Faxes].

For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].
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②② Right - click on the [OKI B840(PCL)], (for B820n this is [OKI
B820]), and select [Printing Preferences].

⑧⑧ Select the custom page added in [Size], and click [OK].

③③ Click [Paper Feed Options] in the [Setup] tab.
④④ Click [Custom Size].

For those using a Mac OS X printer driver

①① Open the file you want to print.
②② Select [Page setup] from the [File] menu.
③③ Click [Paper Size] - [Manage Custom Sizes]. (For Mac OS X
10.3, click on [Custom Paper Sizes] in [Settings].)

⑥⑥ Click [Add].
⑦⑦ Click on [OK].
Memo

•	The created paper will be displayed at the bottom of the [Size]
list in the [Setup] tab. You can define up to a total of 32.

21

Print on any kind of sized paper you want (custom page)

⑤⑤ Select [Paper Type] and enter [Name], [Width], and [Length].

1

Chapter 1 Printing with various kinds of paper

④④ Click [+] on the [Custom Paper Sizes] screen, and enter the
[Name], [Width] and [Height] of the custom paper.

1
Print on any kind of sized paper you want (custom page)

⑤⑤ Click [OK].

The created paper will be displayed at the bottom of the [Paper
Size] list on the [Page Attributes] panel.

Note!

22

• In Mac OS X, you can enter paper sizes outside of the range,
however, these will not be printed correctly, so please enter
values within the range.
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• In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.
• The screen or procedure may vary depending on the application you use.
• Please refer to Online Help for detailed explanations of each setting item for utilities and printer drivers.
• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.

Chapter 2 Convenient Printing Functions

Basic printing method
Those using Windows
Configure various settings on the printer driver and print.

2

There are two ways to configure the settings, depending on the
item to be configured.

•• If printing with settings for often - used functions configured in
advance

①① Select [Start] - [Devices and Printers].

Here, an explanation will be given with WordPad as an example.

Basic printing method

•• If configuring settings for a function at the time you are printing

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
②② Select the printer icon, right click on it and select the printer
driver in [Printing preferences].

If there is only one printer driver installed, select [Printing
preferences].

③③ Select the printer and click [Preferences].

④④ Configure the function you want to use and print.

 Setup Instructions - Chapter 2 Basic Operation

24

If there are two printer drivers installed, select [Printer Properties].

•• If setting the paper size, etc.

①① Open the file you want to print.

②② Select [Page Setup] from the [File] menu.

2
Basic printing method

③③ Configure the function you want to use and click [OK].

 Setup Instructions - Chapter 2 Basic Operation

④④ Open the file you want to print, and print it.

③③ Select the printer from [Format For].

For those using a Mac OS X
Configure various settings on the printer driver and print.
TextEditor is used here as an example.

④④ Configure the paper size and other items and click [OK].
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Chapter 2 Convenient Printing Functions

•• If configuring various function settings

①① Open the file you want to print.
②② Select [Print] from the [File] menu.

2
Basic printing method

③③ Select the panel, and configure the settings for the function
you want to use.

 Setup Instructions - Chapter 2 Basic Operation

④④ Start a print job.
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Print multiple pages on a single sheet
④④ Select [Pages per Sheet] on the [Layout] tab.

Explanation of Functions
Shrink data from multiple pages onto a single sheet of paper and print.

Note!

4

2

3

4

2

• This function shrinks data and prints it, so the printing may not
be correctly centered or the print may be thin.
•	If you change the binding margin value, the other side margin
will increase due to the shrinkage of the overall page with the
combined width of the binding margins.

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

Note!
B840dn

Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Can use

Method of operation
Those using a Windows PS printer driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

• [Draw Borders] and [Pages Per Sheet Layout] cannot be used
in Windows XP/Windows Server 2003.

Those using a Windows PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Select [n-up] (n is the number of pages to print on one sheet)
in the [Setup] tab.

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].
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Print multiple pages on a single sheet

1

2

3

1

If necessary, set [Draw Borders]. Also, you can change the
page layout in [Advanced] - [Pages Per Sheet Layout].

Chapter 2 Convenient Printing Functions

⑤⑤ Click on [Options].

For those using a Mac OS X

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select [Pages per Sheet], [Layout Direction] and [Border] in
the [Layout] panel.

2
Print multiple pages on a single sheet

Memo

⑥⑥ If required, set [Page Borders], [Page layout], and [Bind Margin].
Memo

28

•	You can set the binding margin on the top, bottom, left and
right to be 0 - 30 mm.

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
•	If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

Automatically print on both sides
Explanation of Functions

Method of operation

You can automatically print on both sides of the paper.
Note!

Those using a Windows PS printer driver

• You may be not able to use this, depending on the application you are using.

①① Open the file you want to print.

2

②② Select [Print] from the [File] menu.

1

Both Sides] on the [Layout] tab.

2

2

1

④④ Select [Flip on Long Edge] or [Flip on Short Edge] in [Print on

The paper sizes you can use for double - sided printing are A3, A4,
A5, B4, Letter, Legal14, Legal13.5, Legal13, 8K,16K, B5, Executive
and custom size (width 148 - 297mm, length 182 - 420mm).
The thickness of the paper that can be used for automatic double
- sided printing is a basic weight of 60 - 105g/m2 (ream weight
of 52 - 90kg) Other thicknesses of paper cannot be used as they
may result in a paper jam.
Memo

• Paper sizes other than the above can be manually double side printed.
• Manually do double sided printing (Manual Double - Sided Printing) (P 57)

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Those using a Windows PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

Can use
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Automatically print on both sides

③③ Click on [Preference].

Chapter 2 Convenient Printing Functions

④④ Select [Long Edge (Auto)] or [Short Edge (Auto)] in [2-Sided
Printing] in the [Setup] tab.

For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select [Long-Edge Binding] or [Short-Edge Binding] in [Duplex]
on the [Setup] panel.

2
Automatically print on both sides

Memo

For those using a Mac OS X PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select [Long-Edge binding] or [Short-Edge binding] from [TwoSided] on the [Layout] panel.

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.
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• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
•	If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

Change the paper size
③③ Click on [Preferences].

Explanation of Functions
You can print on different sized paper without changing the print data.

⑤⑤ Click on [Paper Feed Options].

2
Change the paper size

Note!

④④ Select the paper size to edit from [Size] in the [Setup] tab.

• This operation may not work correctly, depending on the application.
•	The [Expand/Shrink] tab in [Job Options] in Properties in
Windows shrink the data, and so they do not change the paper
size.

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

⑥⑥ Put a check in [Resize document to fit printer page], select the

size of paper you want to print on in [Conversion] and click
[OK].

Can use

Method of operation
Those using a Windows PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
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Save toner and print
④④ Put a check in [Toner Saving] in the [Job Options] tab.

Explanation of Functions
Print in order to reduce the amount of toner used.

2

Note!

• If you configure toner - saving, the print quality cannot be guaranteed.

Save toner and print

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use
(The Windows PCL printer driver screen)

Method of operation
Those using Windows

①① Open the file you want to print.

②② Select [Print] from the [File menu].
③③ Click on [Preferences].
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For those using a Mac OS X PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Put a check in [Toner Saving] in the [Job Option] function set
on the [Printer Features] panel.

2
• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

Save toner and print

Memo

For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Put a check in [Toner save] on the [Job Options] panel.

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.
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Print a watermark (stamp print)
④④ Click on [Watermark] in the [Job Options] tab.

Explanation of Functions
You can print an overlay with words such as "Sample" or "Internal and
Confidential", independently of the contents printed from applications.

2
Print a watermark (stamp print)

Sample
Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Can use

Method of operation
Those using Windows

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].
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PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

(The Windows PCL printer driver screen)

⑤⑤ Click [New].

⑥⑥ Enter [Text] on the Edit Watermark screen, and select [Font]
and [Size].

2
Print a watermark (stamp print)

⑦⑦ Click on [OK].

⑧⑧ Check that the watermark to be printed is selected and click
[OK].
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Make a pamphlet (Book - Binding Print)
Explanation of Functions

Method of operation

You can make small books, such as pamphlets.

2

Print the document

9
11
12

Make a pamphlet (Book - Binding Print)

1

Note!

2

3

①① Open the file you want to print.

Back 12

Results of printing

7

Back

Those using a Windows PS printer driver

11

8
10

9

②② Select [Print] from the [File] menu.

7

③③ Click on [Preferences].

12
5

4

3

Specify the book - binding print
Start printing

6

1

4
2

folded into a two-fold

5

Back

1

3

④④ Select [Page Format] on the [Layout] tab. (In Windows XP/

Windows Server 2003, select [Booklet] in [Pages Per Sheet] in
the [Layout] tab.)

• This operation may not work correctly, depending on the application.
•	If the application itself creates PostScript data, the small - book binding settings may not work correctly. Methods to avoid this rely on the
application. Check the manual for the application you are using. For
example, by checking [Print As Image] in the detailed settings with
the printing dialog in Adobe Acrobat or Adobe Reader, small books
will print normally.
•	[Draw Borders] cannot be used in Windows XP or Windows Server
2003.
•	If you cannot print a [Booklet], right click on the [OKI B840 (PS)]
icon in the [Printers and Faxes] or [Printers] folder and put a
check in [Enable Detailed Print Functions] in the [Properties] [Advanced] tab.
• Watermarks cannot be correctly printed on [Booklet].

Note!

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

Can use
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• [Draw Borders] cannot be used in Windows XP/Windows
Server 2003.

B840dn
Windows
PS Printer
Driver

⑤⑤ If necessary, set [Draw Borders].

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

⑥⑥ Click [Advanced] and select the size of paper you are actually
using in [Paper Size].

Memo

• (E.g.) If using A4 size paper to make an A5 size small book.
Select [A4] in [Paper Size] within [Advanced].
•	If making a small book that folds on the right (a book with binding on the right side when the first page is facing up) , select [On
Right Edge] in [Booklet Binding Edge] within [Advanced].

Collate Print
Explanation of Functions

Method of operation

You can print in units of multiple page data sections.
Note!

Those using Windows

①① Open the file you want to print.

• Turn the application's print in parts function off.

2

②② Select [Print] from the [File] menu.
④④ Enter the number of sections to print with in [Copies] in the [Job
Options] tab and put a check in [Collate].

×2 copies

1

2

3
1

2

3
1

2

3

When the collated printing is not specified

×2 copies

1

2

3

1

1

2

2

3

3

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer
driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use
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Collate Print

③③ Click on [Preferences].

When the collated printing is specified

Chapter 2 Convenient Printing Functions

For those using a Mac OS X PS printer driver

⑤⑤ Select the [Collate pages] check box.

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select [Paper Handling] on the panel menu or clear the [Collate
pages] check box on the [Print] screen, and then enter the
number of copies in [Copies].

2
Collate Print

Memo

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

④④ Select [Printer Features] on the panel menu, and then select
the [Collate] check box in the [Job Option] feature set.

Memo

• Printing is performed without using the printer’s memory when
[Paper Handling] is selected on the panel menu and the [Collate
pages] check box is selected.

For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Enter the number of copies in [Copies].

④④ Select [Paper Handling] from the panel menu.
38

• Choose [Job Options] from the panel menu, and click [Advanced], then by un-clicking [The Printer Collate is always
used], you can print without using the printer memory.

Automatically select tray
④④ press the

Explanation of Functions
It is possible to have either tray 1, tray 2 (optional) , tray 3 (optional, B840dn only) or the multi - purpose tray automatically
selected to match the paper size set on the printer driver.
Note!

⑤⑤ Press the
⑥⑥ Press the

Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use

Online button, and [ONLINE] will be displayed.

Set [Paper Source] on the printer driver.
Those using a Windows PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Select [Automatically Select] from [Paper Source] in the [Paper/Quality] tab.

Method of operation

1

ENTER button, and a [*] will appear on the

Set the method of MP tray use on the operating panel.

①① Press the

button several times and the [PRINT MENU]

will be displayed.

②② Press the
③③ Press the

ENTER button.
or the

button several times, and [MP

TRAY USAGE] will be displayed.
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2
Automatically select tray

The type of printer
driver

⑦⑦ Press the

2
B840dn

button several times and [WHEN

right side of the set value.

•	The initial value for the [MP TRAY USAGE] in the menu settings
is [DO NOT USE]. In this case the multi - purpose tray cannot be
subject to automatic selection.

The model you are
using
The environment
you are using the
machine in

or the

MISMATCH] will be displayed.

• You must set the paper size and paper thickness for trays 1 - 3
and the multi - purpose tray on the operating panel.

Operating environment

ENTER button.

Chapter 2 Convenient Printing Functions

Those using a Windows PCL printer driver

For those using a Mac OS X PS printer driver

①① Open the file you want to print.

①① Open the file you want to print.

③③ Click on [Preferences].

③③ Select [All pages From] or [Auto Select] from the [Paper Feed]

②② Select [Print] from the [File] menu.

2

④④ Select [Automatically Select] from [Source] in the [Setup] tab.

②② Select [Print] from the [File] menu.
panel.

Automatically select tray

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.
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Print a large volume with the same paper size
Explanation of Functions
If you set the same paper size and thickness for tray 1, tray 2 (optional) , tray 3 (optional, B840dn only) , and the multi - purpose
tray, you can print from another tray when the paper runs out.
Note!

•	The initial value for the [Method of MP Tray Use] in the menu is [Do
Not Use]. In this case the multi - purpose tray cannot be subject
to automatic selection.

 If using the operating panel, refer to Setup Instructions -

2

Chapter 2 Basic Operation

3

Set [Automatically Switch Trays] on the printer driver.
Those using a Windows PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

Operating environment

③③ Click on [Preferences].

The model you are
using
The environment
you are using the
machine in
The type of printer
driver

tray 2, tray 3, and for the multi - purpose tray.

Print a large volume with the same paper size

• You must set the paper size and paper thickness for trays 1 - 3
and the multi - purpose tray on the operating panel to be the
same. If the paper size and thickness is different between trays,
you will not be able to automatically change between trays.

2 	Set the paper size and thickness to be the same for tray 1,

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

④④ Click [Advanced] in the [Layout] tab.
⑤⑤ Select [On] for [Tray Switch].

Can use

 Method of operation

1

Set the method of MP tray use on the operating panel.

 Automatically Select Tray (P 39)
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Those using a Windows PCL printer driver

If you are using a Mac OS X PS printer driver

①① Open the file you want to print.

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

2

④④ Click [Paper Feed Options] in the [Setup] tab.

②② Select [Print] from the [File] menu.

③③ Put a check in [Tray Switch] in the [Insert Option] function
panel on the [Printer Features] panel.

Print a large volume with the same paper size

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

⑤⑤ Put a check in [Auto Tray Change].
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For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select [Setup] from the panel menu.
④④ Click [Printer Options].

2

⑤⑤ Check the [Auto Tray Switch] check box.

Print a large volume with the same paper size

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.
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Save the printer driver settings and use them again
③③ Change each setting.

Explanation of Functions

④④ Select [Add] on [Driver Settings] in the [Setup] tab.

You can save the details you set on the printer driver.

2

If you save details of settings changed in several places, the printer
driver details will be automatically changed in several places to the
saved details from the next time, just by specifying the driver settings.

Save the printer driver settings and use them again

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use

Method of operation
•• Save settings

⑤⑤ Enter the name of the settings in [The input of the setup name]
and then click [OK].

Those using a Windows PCL printer driver

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Panel] - [Devices and Printers].
For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].
For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

②② Right - click on the icon of the printer you want to use, and select [Printing Preferences].
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Memo

• Save paper information
Put a check in it in order to save the [Media] settings in the
[Setup] tab.
You can save up to a maximum of 14 of them.

•• Use saved settings

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select the settings to use from [Driver Settings] and click [OK].

2
Save the printer driver settings and use them again
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Change the printer driver initial settings
③③ Change each setting and click [OK].

Explanation of Functions
It is convenient to change frequently changed functions in initial
settings.

2

Operating environment

Change the printer driver initial settings

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use

Method of operation
(The Windows PCL printer driver screen)

Those using a Windows printer driver

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Panel] - [Devices and Printers]
For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].

For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

②② Right click the icon of the printer you are using.
Select [Printing Preferences].
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For those using a Mac OS X

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Change each setting.
Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

④④ Select [Save Current Settings as Preset] in [Presets], enter an
appropriate setting name and click [OK].

2
Note!

• [Page Setup] dialog initial settings cannot be changed.
Change the printer driver initial settings

• Select a setting name saved in [Preset] at the time of printing.
•	The operations with settings saved on other drivers cannot be
guaranteed. Save the settings with a name so that you can tell
the model name.
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Use the face up stacker to output sheets in the order of the pages
②② Open the face up stacker.

Explanation of Functions
The paper is output with the printed surface facing up.

2

Operating environment

Use the face up stacker to output sheets in the order of the pages

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

face up stacker

③③ Pull out the paper supporter.

Can use

Note!

• Do not open the face up stacker during printing. This may result in a paper jam.

Method of operation
Those using a Windows PS printer driver

①① Open the rear printer side of the face up cover.

paper supporter

④④ Open the file you want to print.

⑤⑤ Select [Print] from the [File] menu.
face up cover

48

⑥⑥ Click on [Preferences].

⑦⑦ On [Page Order] in the [Layout] tab, select [Back to Front].

2
Use the face up stacker to output sheets in the order of the pages

Memo

• If the [Page Order] item is selected, right - click on the [OKI
B840 (PS)] icon in the [Printers and Faxes] or [Printers] folder
and put a check in [Enable advanced printing features] in the
[Properties] - [Advanced] tab.
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Cancel a print job from the computer
Those using Windows

②② Click [Print & Scan].

①① For Windows 7/Windows Server 2008 R2, select [Start] - [Devices and Printers].
For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers and Faxes].

2
Cancel a print job from the computer

②② Select the printer icon and right - click on it.

Select [See what’s printing] from the displayed menu.

③③ Double click on the printer name.

③③ Click on [Documents] - [Cancel].
Memo

• If the OKI LPR Utility is being installed, you can cancel from it.

 OKI LPR Utility (P 165)
For those using Mac OS X

①① Select [Apple Menu] - [System Preferences].

50

④④ Click on the job you want to delete and then click [x].

Chapter 3 Use various ways to print
Print after entering a password (Secure Print)�������������
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• In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.
• The screen or procedure may vary depending on the application you use.
• Please refer to Online Help for detailed explanations of each setting item for utilities and printer drivers.
• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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Print after entering a password (Secure Print)
④④ Select [Secure Print] from [Job Type] on the [Job Options] tab.

Explanation of Functions
You can store print data on an SD memory card (optional) put into
the printer, and then print from the control panel, after entering a
password.

Memo

3

• If the capacity of the memory card used to store print jobs is
insufficient, [FILE SYSTEM FULL] will be displayed.

Print after entering a password (Secure Print)

Operating environment
If the printer has an SD memory card (optional), you can use it.
Memo

• Prior to inserting an SD memory card, settings must be configured on the printer driver. For details, please refer to Options in
Chapter 1 - Setting Up, within the Setup Instructions.

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Can use

Method of operation

1

Print from the computer.
Those using Windows

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].
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PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

⑤⑤ On the JOB PIN screen enter Job Name and Job Password and
click on [OK].

Memo

• Enter the job name at the time of printing
When you print, the screen to enter the job name appears.
•• Job password
Set a 4 digit number.

⑥⑥ Print.
Memo

• If you put a check in the [Request Job Name for each print
job] box, enter the Job Name on the Job Name Entry screen,
and then click [OK].
•• Job name
Set this as up to a maximum of 16 half - Width (English) characters.

3
Print after entering a password (Secure Print)
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Print secret or important documents (Encrypted Secure Print)
Explanation of Functions

Method of operation

Send to the printer after encrypting print data. By doing this, the
details of the printing can be prevented from leaking, even if print
data is intercepted from the printer communication process or
from an SD card. In order to further strengthen security, print
jobs saved on the SD memory card (optional) are automatically
deleted after a set period of time has passed.

3

You can prevent theft of printed materials by printing after entering a password in the printer control panel.

1

Specify encrypted authenticated printing, and then print
Those using Windows

①① Open the file you want to print.
②② Click on [Preferences].

③③ Click on [Advanced] in the [Job Options] tab.

Print secret or important documents (Encrypted Secure Print)

• Cannot be used with Windows 8 (64bit version)/Windows 8.1
(64bit version)/Windows Server 2012/Windows Server 2012 R2/
Windows 7 (64bit version)/Windows Vista (64bit version)/Windows Server 2008 (64bit version)/Windows Server 2008 R2/Windows XP (x64 version)/Windows Server 2003 (x64 version).

Note!

•	If the capacity of the SD memory card is insufficient to store the
print job, [FILE SYSTEM FULL] will be displayed.

Operating environment
If the printer has an SD memory card (optional), you can use it.
Memo

• Prior to inserting an SD memory card, settings must be configured on the printer driver. For details, please refer to Options
in Chapter 1 - Setting Up, within the Setup Instructions.

The model you are
using
The environment
you are using the
machine in
The type of printer driver

Can use
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B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

(The Windows XP PS printer driver screen)

④④ Confirm that there is a check in the [Job Spool] box, and click
[OK].

⑤⑤ Select [Encrypted Secure Print] from [Job Type] on the [Job Options] tab.

•• Overwrite with Zeros
Delete a print job after overwriting with specific data. This
deletion method is safer than the simple delete method,
however, there is a possibility that print jobs can be restored using a special method.

⑦⑦ Print from the computer. If you put a check in the [Request
Password for each print job] box, enter the [Password] on the
[Secure Setting] screen, and then click [OK].

2

①① Press the

button several times, select [PRINT JOBS

MENU] and press the

②② Press the

button several times, select [ENCRYPTED JOB],

and then press the

(The Windows XP PS printer driver screen)

Memo

• Password
Set 4 - 12 English lower - case characters.
•• Request Password for each print job
At the time of printing a password entry screen appears on
the computer.
•• Auto Erase Time-out
The time for which print jobs are saved to the printer SD
memory card is set as 5 mins - 23 hours 59 mins. Print
jobs that are passed the saving period will be automatically
deleted from the SD memory card.
•• Job Erase
Sets the method to use at the time of deleting print jobs from
the SD memory card.
•• Delete File
Delete a print job using the file system. There is a possibility that
print jobs deleted from the SD memory card using this method
may be restored, however, it is the quickest method of deleting.

ENTER button.

ENTER button.

③③ The password entry screen will appear, so enter the password.
④④ [PRINT/DELETE] is displayed in [ENCRYPTED JOB], so when
printing, select [PRINT], and then press the

ENTER but-

ton. Print encrypted authenticated print jobs.
Memo

• If you make a mistake when entering the password, press the
Back Button, to set it.
•• In order not to print, you can select the
button in Procedure
④ , in order to cancel a job.
•• If [ARE YOU SURE? YES/NO] is displayed, you can check that [YES]
ENTER button to cancel the job.
is selected, and press the
•• After carrying out an encrypted authenticated print, you the
file you used to print will be deleted using the specified deletion method. While the file is being deleted, a message saying
[FILE ERASING] will be displayed.
•• If a data transfer fails, or if it is detected that the data has been
tampered with, a message will be displayed saying [PRESS ONLINE
SW/INVALID SECURE DATA], and the relevant data will be deleted.
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3
Print secret or important documents (Encrypted Secure Print)

⑥⑥ Enter the [Password], and click [OK].

Enter the password on the printer control panel and then print.

Chapter 3 Use various ways to print

Quickly open the computer (buffer print)
③③ Click on [Preferences].

Explanation of Functions
You can store print data in the printer SD Memory Card (optional),
and you can quickly open the computer after large or complex
jobs.
Note!

3

④④ Click on [Advanced] in the [Job Options] tab.

• If the SD Memory Card capacity is too small to store the print
job, [File System Full] will be displayed.
•• Printing is completed quicker when compared with the case
where it is not saved.

Quickly open the computer (buffer print)

Operating environment
If the printer has an SD memory card (optional), you can use it.
The SD memory card requires a COMMON partition.
(The Windows XP PS printer driver screen)

Memo

• Prior to inserting an SD memory card, settings must be configured on the printer driver. For details, please refer to Options
in Chapter 1 - Setting Up, within the Setup Instructions.

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Can use

Method of operation
Those using Windows

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
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PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

⑤⑤ Put a check in the [Job Spool] box.

Manually do double sided printing (Manual Double - Sided Printing)
Explanation of Functions

Operating environment

You can manually print on both sides of the paper you are using,
without using a double - sided printing unit. After printing on one
side, set the paper again, and print on the other side of the paper.

Please refer to the following table regarding custom sizes.

The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

The thickness of the paper that can be used for manual double sided
printing is a basic weight of 60 - 200g/m2 (ream weight of 52 - 172kg).

•• If using tray 1 - 3

PCL Printer
Driver

3

After printing on one side, set the paper again, and print on the
other side of the paper. Tray 1 is used here as an example.
Memo

• You may be not able to use this, depending on the application
you are using.
•• You cannot set multiple copies or a single multiple copies page.
•• After a certain amount of time passes following printing on one
side of the paper (this is initially set to 1 minute), if the online
button is not pressed, the unprinted data will be deleted.
•• You cannot use paper printed on other printers.

PCL Printer
Driver

Method of operation
Those using a Windows PCL printer driver

Note!

Mac OS X

Can use

When doing manual double - sided printing on A6, B6, statement,
or tabloid paper, please use the multipurpose tray (MP tray).

Please check beforehand that the paper you are using for manual
double sided printing does not interfere with the print quality or
the running of the paper.

Windows

• You can print up to 100 pages at a time (with double sided
printing this is 50).

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

Custom sizes with which you can carry out manual double sided printing

Tray 1, 2, 3

Width 148 - 297 mm

Multipurpose tray
Width 76 - 297 mm
(MP Tray)

Length 182 - 432 mm
Length 148 - 432 mm
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Manually do double sided printing (Manual Double - Sided Printing)

The papers sizes on which you can do manual double - sided printing
are: A3, A4, A5, A6, B4, B5, B6, letter, legal (13 inch),
legal (13.5 inch), legal (14 inch), tabloid, executive, statement,
8K (260 × 368 mm), 8K (270 × 390 mm), 8K (273 × 394 mm),
16K (184 × 260 mm), 16K (195 × 270 mm), 16K (197 × 273 mm),
and custom size.

The model you are
using
The environment
you are using the
machine in

Chapter 3 Use various ways to print

④④ On [Source]in the [Setup] tab, select [Tray 1(Standard Cas-

Memo

• Print on the reverse side of the single - sided printed paper.
•• If there is no data for the reverse side, one side will be left
blank, so put it back in the cassette and print in the same order.

P

sette)]. Select [Long Edge (Manual)] or [Short Edge (Manual)]
from [2-Sided Printing].

3

P

Manually do double sided printing (Manual Double - Sided Printing)

⑦⑦ Press an online button start single - sided printing again.
⑤⑤ If single sided printing has finished, remove the paper left in
the tray.

⑥⑥ Reverse the printed paper, and set it as shown in the diagram.
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•• If using the multipurpose tray

①① Open the file you want to print.

⑤⑤ If single sided printing is finished, set the paper as per the diagram and press the Set button.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Select [Multi Purpose Tray] from [Source] in the [Setup] tab.
Select Select [Long Edge (Manual) ]or [Short Edge (Manual)]
from [2-Sided Printing] and print.

3
set button

Manually do double sided printing (Manual Double - Sided Printing)

⑥⑥ Press an online button to print the other side.
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Register a form and then print (Form overlay)
⑤⑤ Click on [Overlay] in the [Job Options] tab, and select [Create

Explanation of Functions

Form].

You can register forms, logs, etc., on the printer, and print overlays.
Memo

• Use the Oki storage manager.

 Oki Storage Device Manager (P 104)
Note!

3

• When using a Windows PS printer driver, computer administrator rights are required.

Operating environment

Register a form and then print (Form overlay)

The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

(Windows XP Screen)

⑥⑥ Print Enter the saved file name and select the destination to
save to.

Can use

Method of operation
Those using a Windows PS printer driver

1

Create a form

①① Make [Ports] into [FILE:]

 Output Print Data to Files (P 64)

②② Launch the application, and create the form which you want to
register on the printer.

③③ Select [Print] from the [File] menu.
④④ Click on [Preferences].
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2

⑦⑦ Restore the [Ports].
Register a form with the Oki Storage Device Manager.

 Oki Storage Device Manager (P 104)

3

Register an overlay on the printer driver, and print.

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Panel] - [Devices and Printers].

For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].
For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

②② Right click the [OKI B840(PS)] icon with your mouse, and select [Printing Preferences].

③③ Set it to use an overlay.

Click on [Overlay] on the [Job Options] tab, and select [Use Overlay].

④④ Click [New].

⑥⑥ Enter the [Overlay Name] and on [Print on Pages] select the

page to which the overlay is to be applied. To set the page
and then apply it, select [Custom] and then enter the page to
which you want to apply it in [Custom Pages].

Memo

• An overlay is a form group. You can register 3 forms on one
overlay. The forms and overlays are overlayed on top of one
another in the order they are registered.

3

into [Form Name], and click [Add].

⑦⑦ Click on [OK].

⑧⑧ Select the overlay to use from the defined overlay, and click on
[Add].

⑨⑨ Start a print job.
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Register a form and then print (Form overlay)

⑤⑤ Enter the form name you registered in Oki Storage Manager

Chapter 3 Use various ways to print

Those using a Windows PCL printer driver

1

⑥⑥ Put a check in [Print Using Active Overlays] in the Overlay
screen, and click on [Define Overlays].

Create a form.

①① Make [Ports] into [FILE:]

 Output Print Data to File (P 64)

②② Launch an application, and create the form which you want to
register on the printer.

3

③③ Start a print job. Enter the saved file name and select the destination to save to.

Register a form and then print (Form overlay)

2

④④ Restore the [Ports].
Register a form with the Oki Storage Device Manager.

⑦⑦ Enter [Overlay Name], and in [ID Value(s)] enter the ID of the
form that you registered in Oki Storage Device Manager.

 Oki Storage Device Manager (P 104)

3

Register an overlay on the printer driver, and print.

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Click on [Vector] in [Print Mode] within the [Job Options] tab.
⑤⑤ Click on [Overlay] in the [Job Options] tab.

Memo

• An overlay is a form group. You can register 3 IDs(form files)
in one overlay. The forms and overlays are overlayed on top of
one another in the order they are registered.

⑧⑧ Select the page you want to apply the overlay to in [Print on

Pages]. To set the page and then apply it, select [Custom] and
then enter the page to which you want to apply it in [Custom
Pages].
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⑨⑨ Click [Add].

⑩⑩ Click [Close].

⑪⑪ Select the overlay to use for printing from the defined overlays,
and click [Add].

3
Register a form and then print (Form overlay)

⑫⑫ Start a print job.
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Output print data to files
Explanation of Functions

For Windows Server 2003, select [Start] - [Printers & Faxes].

②② Right click the icon of the printer you are using.

You can write print data to files and save it.
The saved data can be printed from OKI LPR Utility (if you are using Windows) (P 165).
Note!

3
Output print data to files

• When using Windows, computer administrator rights are required.
•• When outputting print data to a file with Windows 7/Windows Vista/
Windows Server 2008, you may not be able to access the file set as
the output target due to security restrictions. In such a case, you
need to set the output target to a folder and file that the printing
user can access, such as C:\Users\(Logon User Name)\Documents.

Select [Printer properties].

③③ Select FILE: in [Ports] on the [Port] tab, and click [OK].

④④ Start a print job. Enter [Output Target File Name] within [Print
to File], and then click [OK].

Operating environment
The model you are
using
The environment
you are using the
machine in
The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

Can use

For those using a Mac OS X
Method of operation
Those using Windows

①① For Windows 8/8.1/Server 2012/2012 R2, select [Control
Panel] - [Devices and Printers].

For Windows 7/Windows Server 2008 R2, select [Start] [Devices and Printers].
For Windows Vista/Windows Server 2008, select [Start] [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
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①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Click on [PDF], and select the destination to save to.

3

④④ Enter the file name you want to save with in [Name], select
the destination to save to and click [Save].

Output print data to files
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Printing PostScript Errors
⑤⑤ On [PostScript Options] - [Send PostScript Error Handler],

Explanation of Functions
If a PostScript error occurs, you can print the details of the error.
Operating environment
The model you are
using
The environment
you are using the
machine in

3

The type of printer driver

B840dn
Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Printing PostScript Errors

Can use

Method of operation
Those using a Windows PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Click [Advanced] in the [Layout] tab.
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PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

select [Yes].

Chapter 4 Printing neatly
Changing the resolution and then printing���������������
Change the print density��������������������������
Changing the finish of the printed image����������������
Preventing cracks in fine lines�����������������������
Replace with the printer font and print�����������������
Print using the computer font�����������������������

Note!
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• In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.
• The screen or procedure may vary depending on the applicaiton you use.
• Please refer to Online Help for detailed explainations of each setting item for printer drivers and utilities.
• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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Changing the resolution and then printing
④④ Select the resolution on [Quality] in the [Job Options] tab.

Explaination of Functions
You can change the resolution and then print.

Note!

• If you specify [High Quality] then you may not be able to print
complex files. In such a case print it with [Normal]
•• This printer carries out print processing on the computer side.
If you use a computer with a high processing speed, you can
shorten the printing time.

Operating environment

4

The model you are

B840dn

using
The environment you

Changing the resolution and then printing

are using the machine in
The type of printer
driver

Windows
PS Printer
Driver

PCL Printer
Driver

B820n
Mac OS X

PS Printer
Driver

Can use

Method of operation
Those using a Windows printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

68

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

(The Windows PCL printer driver screen)

For those using a Mac OS X PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select the resolution from the [Quality] on the [Job Option]
function set on the [Print Features] panel.

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Select the resolution from the [Print Quality] on the [Job Options] panel.

4
Changing the resolution and then printing

Memo

• I f setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• I f the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.
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Change the print density
④④ Press the

Explanation of Functions
You can change the print density to five different levels. If small
characters may get smudged or if the image data is dense, then set
it in the "Light (Minus)" direction. If fine lines may get broken, set it
in the "Dense (Plus)" direction.
Memo

•F
 or Windows, if you put a check in [Adjuster Printer Printing
Density] the printer driver settings will be prioritized.

Operating environment

4

The model you
are using
The environment
you are using
the machine in

B820n

Windows

Change the print density

PS Printer
Driver

Can use

×

Mac OS X

PCL Printer
Driver

PS Printer
Driver

PCL Printer
Driver

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

×

Method of operation
Use the control panel to change.

①① Press the

or

button several times. The [MAINTE-

NANCE MENU] will be displayed, and press the

ENTER but-

ton.

②② Press the

or

button several times. [DARKNESS/0]

will be displayed, and press the

③③ Press the
70

or the

right side of the set value.

⑤⑤ Press the

Online button, and [ONLINE] will be displayed.

Those using a Windows PCL printer driver

①① Open the file you want to print.
B840dn

The type of
printer driver

ENTER button, and a [*] will appear on the

ENTER button.

button to display the target value.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Click on [Advanced] in the [Job Options] tab.

⑤⑤ Put a check in [Printer Darkness] and select the appropriate
value.

⑤⑤ Select the appropriate value from [Density].

Memo

①① Open the file you want to print.

• I f the print option is not displayed in the print dialog box for
Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

②② Select [Print] from the [File] menu.

③③ Select [Job Options] from the panel menu.
④④ Click [Advanced].
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4
Change the print density

For those using a Mac OS X PCL printer driver

• I f setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.

Chapter 4 Printing neatly

Changing the finish of the printed image
④④ Change the settings for [Dithering Pattern], [Dithering Tex-

Explanation of Functions
The overall print result of the image is determined by the print
driver settings. Try out various settings until you get the result
you want.

ture], and [Manual Adjustment] in the [Image] tab.

Operating environment
The model you
are using

B840dn

The environment
you are using the
machine in

4

B820n

Windows

The type of printer
driver

PS Printer
Driver

Can use

×

PCL Printer
Driver

Mac OS X
PS Printer
Driver

PCL Printer
Driver

Changing the finish of the printed image

Those using a Windows PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

72

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

×

Method of operation

③③ Click on [Preferences].

Windows

⑤⑤ Click on [Quality] in the [Job Options] tab.
⑥⑥ Click on [Advanced].

⑦⑦ Change the [Increase brush density].

Memo

• If setting details are not displayed in the print dialog box for
Mac OS X 10.7 to 10.9, click [Show Details] at the bottom of
the dialog box.
• If the print option is not displayed in the print dialog box
for Mac OS X 10.6.8, click the disclosure triangle next to the
[Printer] drop-down list.

④④ Change the [Print Quality] in the [Job Options] panel.

4
Changing the finish of the printed image

For those using a Mac OS X PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.

③③ Change the [Dithering Pattern], [Dithering Texture], [Brightness] and [Contrast] settings in the [Image] panel.
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Preventing cracks in fine lines
⑤⑤ Put a check in [Adjuster ultra fine lines].

Explanation of Functions
If you set extra - fine lines from the application, this will prevent
the lines from breaking. This function is set to ON as standard.
Memo

•D
 epending on the application, the spaces in bar codes, etc.,
may become more narrow. In such a case, turn this function
to OFF.

Operating environment

4

The model you
are using
The environment
you are using
the machine in

Preventing cracks in fine lines

The type of printer
driver

B840dn
Windows
PS Printer
Driver

Can use

B820n
Mac OS X

PCL Printer
Driver

PS Printer
Driver

×

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

PCL Printer
Driver

×

×

×

Method of operation
Those using a Windows PS printer driver

①① Open the file you want to print.

(The Windows XP PS printer driver screen)

For those using a Mac OS X PS printer driver

①① Open the file you want to print.
②② Select [Print] from the [File] menu.
③③ Put a check in [Adjust ultra fine lines] in the [Job Option]
function set within the [Printer Features] panel.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Click on [Advanced] in the [Job Options] tab.

Memo

• If setting details are not displayed in the print dialog box for Mac OS
X 10.7 to 10.9, click [Show Details] at the bottom of the dialog box.
• If the print option is not displayed in the print dialog box for Mac OS X
10.6.8, click the disclosure triangle next to the [Printer] drop-down list.
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Replace with the printer font and print
Explanation of Functions
You can replace the TrueType font with the printer internal font
and print.
Note!

②② Right - click on the (OKI B840(PS)) icon, and select [Properties].
③③ Replace the TrueType font with the printer font in [Font Substitution Table] within the [Device Settings] tab, and then click [OK].

• The font replacement function preserves the appearance of the
document, but it does not reproduce the design of the font. If
you need to correctly print the design of the font, disable the
font replacement function.

Operating environment
The model you
are using

The type of printer
driver

B840dn
Windows
PS Printer
Driver

Can use

PCL Printer
Driver

4

B820n
Mac OS X

PS Printer
Driver

PCL Printer
Driver

×

×

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

×

Method of operation
Those using a Windows PS printer driver

①① For Windows 8.1/Windows 8/Windows Server 2012 R2/Windows

Server 2012, select [Control Panel] - [Hardware and Sound] - [Devices and Printers].
For Windows 7/Windows Server 2008 R2, select [Start] -[Devices
and Printers].
For Windows Vista/Windows Server 2008, select [Start] - [Control
Panel, and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes]

Replace with the printer font and print

The environment
you are using the
machine in

④④ Open the file you want to print.

⑤⑤ Select [Print] from the application [File] menu.
⑥⑥ Click [Advanced] in the [Layout] tab.

⑦⑦ Select [Substitute with Device Font] in [TrueType Font].
⑧⑧ Start a print job.

Those using a Windows PCL printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Select [Vector] in [Print Mode] within the [Job Options] tab.
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⑤⑤ Click on [Font].

4
Replace with the printer font and print

⑥⑥ Check [Font Substitution].

⑦⑦ Select which printer font to replace the TrueType font with in
[Font Substitution Table].

⑧⑧ Start a print job.
76

Print using the computer font
⑤⑤ Select [Substitute with Device Font] in [TrueType Font].

Explanation of Functions
You can output a TrueType font exactly the same as you see it on
the screen.
Note!

• This will make the printing time longer.

Operating environment
The model you
are using
The environment
you are using
the machine in

B820n

Windows
PS Printer
Driver

PCL Printer
Driver

Can use

Mac OS X
PS Printer
Driver

PCL Printer
Driver

×

×

Windows

Mac OS X

PCL Printer
Driver

PCL Printer
Driver

×

4
⑥⑥ Print.

Print using the computer font

The type of printer
driver

B840dn

Those using a Windows PCL printer driver

①① Open the file you want to print.
Method of operation
Those using a Windows PS printer driver

①① Open the file you want to print.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Select [Vector] in [Print Mode] within the [Job Options] tab.

②② Select [Print] from the [File] menu.
③③ Click on [Preferences].

④④ Click [Advanced] in the [Layout] tab.
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⑤⑤ Click on [Font].

4
Print using the computer font

⑥⑥ Un-click on [Font Substitution].
Memo

• Download as outline font
Create a font image on the printer.
•• Download as bitmap font.
Create a font image with the printer driver.

⑦⑦ Start a print job.
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Configure the IP Address
Set the printer's IP address, subnet mask, and gateway address from
the printer control panel.
Note!

• I f there is a mistake entered in the IP address, subnet mask, or
gateway address, the network may go down or a major fault may
arise. Please set your IP address after consulting with your network administrator.

⑥⑥ One digit of the IP address will be flashing, and press the
or the
played.

button, and the value you want to set will be dis-

If you press and hold the button for 2 seconds or longer, it will
be sent quickly.

①① Turn the printer power ON.

IP ADDRESS
192.
0.

②② Check that [ONLINE] is displayed on the control panel.
③③ Press the

or the

button several times, and the

0

ENTER button. Two digits of the IP address will

be flashing.

[NETWORK MENU] will be displayed.

5

⑦⑦ Press the

0.

Repeat steps

-

and set all the digits.

NETWORK MENU

Configure the IP Address

IP ADDRESS
192 . 168.

④④ Press the

⑧⑧ Press the

TCP/ I P
ENABLEޓޓޓޓޓޓޓ㧖

and press the

button several times, select [IP ADDRESS],

0.

Back button.

⑨⑨ Press the

button several times, and set the [SUBNET
MASK] and [GATEWAY ADDRESS] using the same procedure.

⑩⑩ If you have finished configuring the settings, press the

Online button. The values set in the printer are saved and the
network function is restarted.

ENTER button.
IP ADDRESS
ޓ0 .
0.

80

2＊

ENTER button. If [TCP/IP] is set to [DISABLE],

change it to [ENABLE].

⑤⑤ Press the

0.

0㧖

If [ONLINE] is displayed in the control panel, then the procedure is complete.

Change the time it takes to go into power save mode
Set the time it takes to go into power save mode.
The time until print starts may be shorter with longer times to go
into power save mode.
After a set period, if data is not received, then the machine goes into
power save mode.

Note!

•S
 etting [POWER SAVE] to [DISABLE] and using the machine for
long periods of time increases the likelihood of an effect on the
life of the components of the machine (such as the fan).

①① Press the

button several times, select [SYS CONFIG
ENTER button.

MENU], and then press the

②② As [POW SAVE TIME] is selected, presse the

5

ENTER but-

③③ Press the

or the

button several times, select the

time to set, and then press the

④④ Press the

Memo

Change the time it takes to go into power save mode

ton.

ENTER button.

Online button, and [ONLINE] will be displayed.

• I f you set [POWER SAVE] in the [MAINTENANCE MENU] to
[DISABLE], the machine will not go into power save mode.
However, in order to maintain a temperature at which the
fuser unit can print, power will still be used. Please turn the
printer power OFF when you are not using it.
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Change the time it takes to go into sleep mode
Set the time it takes to go into sleep mode.
If the machine goes into power save mode and does not receive any
data within a set time, it will go into sleep mode.
This is the explaination of the procedure to change the time on the
control panel.

①① Press the

button several times, select [SYS CONFIG

MENU], and press the

②② Press the

ENTER button.

5

button, select [SLEEP TIME], and press the

Change the time it takes to go into sleep mode

Memo

or the

button several times, select the
ENTER button.

Online button, and [ONLINE] will be displayed.

• If you set [SLEEP] in [MAINTENANCE MENU] to [DISABLE], the
machine will not go into sleep mode.

How to get out of sleep mode
In order to get out of sleep mode, either press the

Online

button or send some print data to the printer through a computer
connected via a network or through the USB.
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If the printer goes into sleep mode, press the

Online button

on the control panel, and check that [ONLINE] is displayed.
If [ONLINE] is displayed, the following restriction itmes apply.
• If [PARALLEL] in the [PARALLEL MENU] is set to [ENABLE], the
printer cannot go into sleep mode.

Those using Windows

time to set, and then press the

④④ Press the

When the machine goes into sleep mode, the following limits apply
to the printer driver and utility functions.

Note!

ENTER button.

③③ Press the

Restrictions When in Sleep Mode

Software Name

Restrictions When in Sleep Mode

Methods of dealing
with it other than
pressing the Online
button

Network Extension

Cannot connect to the machine.

–

Network Card Setup

Cannot search the machine or adjuster settings.

–

PrintSuperVision

Cannot monitor consumables or the
number of pages printed, etc.

–

Oki Storage
Device Manager

If the printer is connected via a parallel interface, printer searching and
setting configuration cannot be done.

Web Driver Installer

• When installing a driver, you cannot automatically get printer option
information.
• You cannot manually register the
printer on a WDI server.

Connect to a
network or a USB
printer.
–

Software Name
Driver Installer

Restrictions When in Sleep Mode
• If there is a connection with the
network, you cannot get printer option information automatically when
the driver is being installed.

Methods of dealing
with it other than
pressing the Online
button
–

Restrictions When in Sleep Mode

1) NetBEUI
2) NBT
3) NetWare
Methods of dealing
with it other than
pressing the Online
button

Printer Drivers

You cannot print if connected with
AppleTalk.

Network Card
Setup

Cannot search the machine or adjuster settings.

–

MicrolinePS
Utilities

You cannot print if connected with
AppleTalk.

–

Connect to a printer
with TCP/IP or USB.

In sleep mode, the following constraints apply to network functions.
• Cannot go into sleep mode.

If
If
If
If
If

IPSec is activated.
NetBEUI is activated.
NetWare is activated.
EtherTalk is activated.
a TCP connection is being established.

E.g.: If establishing a connection with telnet or ftp.
In Power Save Mode, after some time passes and it goes to
sleep, if the connection is broken it will go into sleep mode.

4) EtherTalk *1
5) Bonjour *1
*1 When using Mac OS X, you can print while in sleep mode
with an IP Print connection.
• Cannot Search/Change Settings

In sleep mode, you cannot search or change settings with the
following functions/protocols.
1) PnP - X
2) UPnP
3) Bonjour
4) LLTD
5) FLDP
6) ODNSP
7) JCP
8) MIB *2
*2 You can refer to part of MIB while in sleep mode (Get
Comment).

83

5
Change the time it takes to go into sleep mode

Sleep mode network function restriction items

1)
2)
3)
4)
5)

• Cannot Print

In sleep mode, you cannot print with the following protocols.

Those using Macintosh
Software Name

If you want to activate sleep mode, please deactivate IPSec/
NetBEUI/NetWare/EtherTalk.

Chapter 5 How to use the control panel

• Protocols with the client function do not work

1) Email alert *3
2) SNMP Trap
3) WINS*4
4) SNTP
*3 T
 his does not include intervals between times of regular
notifications when some time has passed in sleep mode.
*4 T
 his does not include intervals between WINS updates when
some time has passed in sleep mode.
In order to carry out regular WINS updates in sleep mode,
the names registered on the WINS server may be deleted.
• Protocols that need to have sleep mode deactivated to be used

When using the following protocols, deactivate sleep mode.

5

1) IPv6

Change the time it takes to go into sleep mode

2) NetBEUI
3) NetWare
4) EtherTalk
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Cancel a print job

Check printer internal fonts

You can cancel data that is being processed by the printer.

Note!

• You cannot cancel jobs that have started to print.

①① Press the Cancel button on the printer's operating panel to
cancel a print job.

[Cancel] Button

The printer will print its internal font name as standard.
Note!

• If you are printing on paper other than A4, it may be that not
all of the contents will be printed out.
•• You cannot print if [Local Print] in Print Control Server is set to
[Cannot Print] or [Cannot Print in Color].

①① Set A4 paper in the tray.
②② Press the

button several times, select [INFORMATION

MENU], and press the

③③ Press the

ENTER button.

button several times, select [PRINT PSE FONT/

EXECUTE], [PRINT PCL FONT/EXECUTE], or [PRINT PPR FONT/
EXECUTE], [PRINT FX FONT/EXECUTE] and press the
• If the printer is connected to a computer using a USB, and if
you cannot print normally after having cancelled a print job
from the computer, remove and reinsert the USB cable, or
turn the printer power OFF ( )/ON( l ).

5

TER button.
Cancel a print job / Check printer internal fonts

Memo

EN-
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Initializing an SD memory card (optional)
You can return SD cards to their initialized state.
An SD memory card on B840dn is divided into three partitions ([PS],
[PCL], and [Common]), and into two partitions on B820n ([PCL] and
[Common]).
Memo

• [PS] (B840dn only)
This is a PostScript mode form storage area.
• [PCL]
This is a PCL mode form storage area.
• [Common]
This is an area that stores jobs registered to Encrypted Authenticated Print, Authenticated Print, Save to Printer and errors.

Initializing an SD memory card

①① Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation
result menu to [DISABLE].

 Setup Instructions, Chapter 2: Basic Operation - List of the
PRINT STATISTICS

②② Turn off the power to the printer.

 Setup Instructions, Chapter 1: Setting Up - Turning Off the Printer

③③ Hold the

ENTER button down on the printer control panel

in order to turn the power on.
Note!

5
Initializing an SD memory card (optional)

Memo

• If you initialize an SD memory card, the following contents will
be deleted.
Please carefully check whether it is ok to initialize the card.
Data registered in Encrypted Authenticated Print, Authenticated Print, Save to Printer
Registered forms
Error Logs
• You can also format just a particular partition.
• If a printer has already been added in print control server, it is
necessary to delete all print control server related information
from the printer SD memory card in print control server prior
to initializing the SD memory card. In order to do this, finish
log acquisition, and delete the printer in print control server.

SD memory card initialization can also be carried out on the Oki
Storage Device Manager (Windows).

Note!

ENTER button.

• Press and hold the

④④ When [ADMIN MENU] is displayed in the control panel, release
ENTER button.

the

⑤⑤ Press the

ENTER button and [ENTER PASSWORD] will be

displayed. Press the

or

play the first digit of the password, and press the

ENTER

button.
Use the same procedure to enter characters 6 - 12 of the
password.
Memo

• The default password is "aaaaaa".

⑥⑥ Press the

or

button several times, select [FILE SYS

MAINTE2], and press the
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button several times to dis-

ENTER button.

⑦⑦ Press the

or the

LOCK], and press the

⑧⑧ Press the
and press the

or the

button several times, select [INITIAL
ENTER button.

Formatting a particular partition

①① Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation
result menu to [DISABLE].

 Setup Instructions, Chapter 2: Basic Operation - List of the

button several times, select [NO],

PRINT STATISTICS

②② Turn off the power to the printer.

ENTER button.

 Setup Instructions, Chapter 1: Setting Up - Turning Off the
Printer

⑨⑨ Press the

Back button, and [FILE SYS MAINTE2] will be

displayed.

⑩⑩ Press the
press the

③③ Hold the

in order to turn the power on.
Note!

button once, select [FILE SYS MAINTE1], and
ENTER button.

ENTER button and [ENTER PASSWORD] will be
or

button several times to display

the first digit of the password, and press the

⑫⑫ [ARE YOU SURE? YES/NO] will be displayed. Pres the

button

ENTER button.

⑬⑬ [EXECUTE NOW? YES/NO] will be displayed. Press the
ton several times, and select [YES], then press the

⑤⑤ Press the

displayed. Press the

button.

several times and select [YES], then press the

5

ENTER button.

butENTER

button.
Start initialization of the SD memory card. The printer will automatically restart.
Initialization will be complete when [ONLINE] is displayed in
the control panel.

ENTER button.

Use the same procedure to enter characters 6 - 12 of the
password.
Memo

• The default password is "aaaaaa".

⑥⑥ Press the

or

button several times, select [FILE SYS

MAINTE2], and press the

⑦⑦ Press the

or the

LOCK], and press the

ENTER button.
button several times, select [INITIAL
ENTER button.
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Initializing an SD memory card (optional)

ENTER

ENTER button.

• Press and hold the

④④ When [ADMIN MENU] is displayed in the control panel, release
the

⑪⑪ [SD INITIALIZE] will be displayed, and press the

ENTER button down on the printer control panel

Chapter 5 How to use the control panel

⑧⑧ Press the

or the

and press the

ENTER button.

⑨⑨ Press the

Back button, and [FILE SYS MAINTE2] will be displayed.

⑩⑩ Press the

button once, select [FILE SYS MAINTE1], and

press the

⑪⑪ Press the
press the

5

button several times, select [NO],

⑫⑫ Press the

ENTER button.
button once, select [SD FORMATING], and
ENTER button.
button several times, select the partition you

Initializing an SD memory card (optional)

want to format (PCL/COMMON/PS (B840dn only)), and press
the

ENTER button.

⑬⑬ [ARE YOU SURE? YES/NO] will be displayed. Pres the
several times and select [YES], then press the

button

ENTER button.

⑭⑭ [EXECUTE NOW? YES/NO] will be displayed. Press the
button several times, then press the

ENTER button.

Start the partition formating. The printer will automatically restart.
Initialization will be complete when [ONLINE] is displayed in
the control panel.
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Check the Free Space in an SD Memory Card (Optional) or Flash Memory
There are several ways to check the free space in an SD memory
cards (optional) or flash memory.
For SD memory cards
• Delete Unwanted Data from an SD Memory Card

•Y
 ou can use the Oki Storage Device Manager (Windows) to free
up space.
 Oki Storage Device Manager (P 104)

①① Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation
result menu to [DISABLE].

 Setup Instructions, Chapter 2: Basic Operation - List of the

Delete data left in the [Common] partition of an SD memory card.
Print data specifying authenticaed print jobs and encrypted authenticated print jobs is left behind in the [Common] partition.




Print after entering a password (Secure Print) (P 52)
 rint secret or important documents (Encrypted Secure Print)
P

PRINT STATISTICS

②② Turn off the power to the printer.

 Setup Instructions, Chapter 1: Setting Up - Turning Off the

(P 54)

Printer

Memo

• This does not change the free space in thePS (B840dn only)
and PC partitions.

• Change the size of SD memory card partitions

Note!

Memo

• Changing the size of a partition will delete the following. Please
check if it is ok to delete these.
Data registered with Encrypted Secure Print and Secure Print
Registered forms
Error Logs
• If the printer has already been added to print control server,
prior to changing the size of the partition, it is necessary to
delete all print control server related information. In order to
do this, finish log acquisition, and delete the printer from print
control server.

ENTER button down on the printer control panel

in order to turn the power on.
Note!

• Press and hold the

ENTER button.

④④ When [ADMIN MENU] is displayed in the control panel, release
ENTER button.

the

⑤⑤ Press the

ENTER button and [ENTER PASSWORD] will be

displayed. Press the

or

button several times to dis-

play the first digit of the password, and press the

ENTER

button.
Use the same procedure to enter characters 6 - 12 of the
password.
Memo

• The default password is "aaaaaa".
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5
Check the Free Space in an SD Memory Card (Optional) or Flash Memory

By reducing the size of partitions that you do not use, you can free
up space in your target partition.

③③ Hold the

Chapter 5 How to use the control panel

⑥⑥ Press the

or the

button several times, select [FILE

SYS MAINTE2], and press the

⑦⑦ Press the

or the

LOCK], and press the

ENTER button.

button several times, select [INITIAL

⑭⑭ [ARE YOU SURE? / YES] will be displayed. Press the
button several times and select [YES], and then press the
ENTER button.
The printer will restart automatically.
Initialization will be complete when [ONLINE] is displayed in

ENTER button.

the control panel.

⑧⑧ Press the

or the

button several times, select [NO],
For flash memory

ENTER button.

and press the

• Initializing flash memory

⑨⑨ Press

the

5

⑩⑩ Press the

Check the Free Space in an SD Memory Card (Optional) or Flash Memory

press the

⑪⑪ Press the

Back button, and [FILE SYS MAINTE2] will be displayed.

Note!

button once, select [FILE SYS MAINTE1], and
ENTER button.

or the

90

PRINT STATISTICS

 Setup Instructions, Chapter 1: Setting Up - Turning Off the

button several times, select the partition
ENTER button.

button several times to display the

item you want to set, and press the
Memo

 Setup Instructions, Chapter 2: Basic Operation - List of the
②② Turn off the power to the printer.

which you want to change the size of, and press the

⑬⑬ Press the

①① Set [PRINT STATISTICS]−[USAGE REPORT] on the aggregation

button several times, and [PARTITION SIZE]

or the

• If you initialize a flash memory card, the following contents will
be deleted. Please check if it is ok to delete these.

result menu to [DISABLE].

will be displayed.

⑫⑫ Press the

You can return SD cards to their initialized state.

ENTER button.

• I f you change the size of the PCL partition, the size of the
Common partition will also change. Changing the Common and
PS partition sizes is the same.

Printer

③③ Hold the

ENTER button down on the printer control panel

in order to turn the power on.
Note!

• Press and hold the

ENTER button.

④④ When [ADMIN MENU] is displayed in the control panel, release
the

ENTER button.

⑤⑤ Press the

button several times, select [FLASH INITIAL-

IZE / EXECUTE], and press the

ENTER button and [ENTER PASSWORD] will be

displayed. Press the

or

button several times to display

the first digit of the password, and press the

ENTER button.

Use the same procedure to enter characters 6 - 12 of the password.
Memo

⑪⑪ Press the

ENTER button.

⑫⑫ [ARE YOU SURE? / YES] will be displayed. Press the
button several times and select [YES], and then press the
ENTER button.
Start initialization of the flash memory card. The printer will
automatically restart.

• The default password is "aaaaaa".

⑥⑥ Press the

or

button several times, select [FILE SYS
ENTER button.

MAINTE2], and press the
or the

LOCK], and press the

⑧⑧ Press the
and press the

⑨⑨ Press the

or

5

button several times, select [INITIAL

Check the Free Space in an SD Memory Card (Optional) or Flash Memory

⑦⑦ Press the

Initialization will be complete when [ONLINE] is displayed in
the control panel.

ENTER button.
button several times, select [NO],

ENTER button.

Back button, and [FILE SYS MAINTE2] will be

displayed.

⑩⑩ Press the
press the

button once, select [FILE SYS MAINTE1], and
ENTER button.
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Enabling parallel interfaces
The default setting for parallel interfaces is disabled. If printing using
a parallel interface, enable it on the control panel.

Note!

• I f parallel interfaces are enabled the printer cannot go into sleep
mode. In such a case, the power used will be higher than international ENERGY STAR Program standards.

①① Press the

or

button several times. The [PARALLEL

MENU] will be displayed, and press the

②② Press the

5

or

played, and press the

Enabling parallel interfaces

③③ Press the

or the

ENTER button.

button several times. [PARALLEL] will be dis-

ENTER button.
button, and [ENABLE] will be dis-

played.

④④ Press the

ENTER button, and a [*] will appear on the right

side of the set value.

⑤⑤ Press the

Online button, and [ONLINE] will be displayed.

⑥⑥ Turn the printer power OFF ( ) /ON ( l ).

 Setup Instructions, Chapter 1: Setting Up - Turning Off the
Printer
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Change parallel interface forwarding mode
You can change it if the computer and forwarding mode are aligned.

①① Press the

Disable Bi - Directional Centro

①① Press the

or

button several times. The [PARALLEL

MENU] will be displayed, and press the

②② Press the

or

ENTER button.

button several times. The [PARALLEL/

ENABLE] will be displayed, and press the

③③ Press the

or the

ENTER button.

button several times, and [DIS-

ABLE] will be displayed.
ENTER button, and a [*] will appear on the

right side of the set value.

⑤⑤ Press the

Online button, and [ONLINE] will be displayed.

⑥⑥ Turn the printer power OFF ( ) /ON ( l ).

or

button several times. The [PARALLEL

MENU] will be displayed, and press the

②② Press the

or

button several times. [ECP/ENABLE]

will be displayed, and press the

③③ Press the

ENTER button.

or the

ENTER button.

button several times, and [DIS-

ABLE] will be displayed.

④④ Press the

5

ENTER button, and a [*] will appear on the

right side of the set value.

⑤⑤ Press the

Online button, and [ONLINE] will be displayed.

⑥⑥ Turn the printer power OFF ( ) /ON ( l ).

 Setup Instructions, Chapter 1: Setting Up - Turning Off the
Printer

 S etup Instructions, Chapter 1: Setting Up - Turning Off the
Printer
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Change parallel interface forwarding mode

④④ Press the

Disable ECP

Chapter 5 How to use the control panel

(MEMO)

5
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Chapter 6 Useful Utilities (Windows)

Explanation of Utilities
We explain here utilities that make the Windows environment you
are using more convenient.
Utility Name

Function

Model
supported

Storage
location

Configuration Tool You can check the printer B840
network settings and status. B820
IP you can change the IP address.

Software
DVD - ROM

This is a utility for configuring B840
printer flash memory settings, B820
and registering and deleting
form data.

Software
DVD - ROM

PS Gamma
Adjuster

You can adjuster the printer B840
half - tone density and the
print density of photos.

Software
DVD - ROM

Web browser

You can configure the printer
B840
menu or network settings reB820
motely on the web screen.

Oki Storage
Device Manager

6

104

Explanation of Utilities

Network Exten- You can check setting items B840
sion
from the printer driver and set B820
the composition of printer options.

Software
DVD - ROM

You can check the printer B840
network settings and status. B820
IP you can change the IP address.

Software
DVD - ROM

Network Card
Setup

96

165

173

176

Function

Model
supported

Storage
location

You can use TELNET to set B840
printer network settings.
B820

Web Driver
Installer

Print Job
Accounting

This is a web application that B840 You can
is installed on the client com- B820 download this
from the Oki
puter, and which can be used
Data webto view printers connected to
page.
the network and download
printer driver installed modules.

Different restrictions on printing
can be set depending on the
print jobs from computer by
users, and print information
can be captured as records.
Print Job
To use Print Control Server to
Accounting Client recognize users, Job Account
ID can be configured on the
printer driver.

Reference
page

184

PrintSuperVision This is a web - based applica- B840 You can
tion which manages printers B820 download this
from the Oki
connected to the network. You
Data webcan use this to check setting
page.
information and information
on consumables for multiple
printers.

109

121
Software
DVD - ROM

TELNET

Reference
page
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You can print, manage print B840
jobs, and check the printer B820
status through a network connection.

OKI LPR Utility

Utility Name

B840
B820

You can
download this
from the Oki
Data webpage.

B840
B820

You can
download this
from the Oki
Data webpage.

Configuration Tool
Configuration Tool is a utility that can be used to display printer
information, change printer settings, and manage printers.
Operating environment
Windows 8.1/Windows 8/Windows Server 2012/Windows Server
2012 R2/Windows 7/Windows Vista/Windows Server 2008/
Windows Server 2008 R2/Windows XP/Windows Server 2003 and
with Internet Explorer 6.0 or higher installed

Note!

• For setup, computer administrator rights are required.
•Y
 ou may not be able to use a part of the functions, depending
on your user settings. In such a case, log in as the computer
administrator.

How to install

①① Set the Software DVD - ROM in the drive.

②② Click [Optional Software] - [Configuration Tool].
③③ Select the plugin to install.

Memo

• Network Setting Plugin
Configure IP settings or reset the printer and display the
webpage.
• Install and add on the Plug - in menu.
• You can install additional plugins later.

④④ Set the folder you wish to save to.
⑤⑤ Click on [Install].

⑥⑥ If [Installation is completed.] is displayed, click [Close].
If the restart screen is displayed, follow the instructions on the
screen to restart the computer.
Main methods of use
• When first launching/ when first adding a printer
When using the Configuration Tool for the first time or when introducing a printer for the first time, register the printer in Configuration Tool.

Configuration Tool

①① Select [Start] - [All Programs] - [Okidata] - [Configuration

6

Tool] - [Configuration Tool].

[Register Device] in the [Tools] menu, and search for

②② Select
printers that can be registered.
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Memo

• I n order to change the range in which you are searching for
the printer you are using, select [Environment Settings] in the
[Tools] menu.
Enter the range you want to search and click [OK].

• Reference printer information

①① Click on the printer from [Registered Device Table] for which
you want to see information.

②② The printer status and printer information are displayed.
Memo

③③ Put a check in the printers you want to configure settings for
or to manage, and click on [Register].

6

• I f you want to update information, click on [Update Device
Information].
••The device status is displayed if the printer is connected to a
network.

• Network Setting Menu
This is displayed if the Network Setting Plugin is displayed. You
can set the IP address for the printer you are using, enable/disable device settings (Web), and set the website display settings.

Configuration Tool

①① Click [Network Setting] within [Plug-ins] in the menu.
The Network Setting main screen is displayed.

④④ Either click on the

on the upper right or click on [Cancel] to
close the [Register Device] screen.

98

• Search for the machine on the network

①① Click on [Environment Settings].

③③ You can start searching for printers on the network with [Discover Devices].

Memo

②② Enter the search conditions and click [OK].

Memo

• If at the time of searching on Windows 7/Windows Vista/
Windows Server 2008/Windows Server 2008 R2/Windows XP/
Windows Server 2003 there is a message displayed saying
[Windows Security Alert], click [Allow access].

• You can enter up to 16 IP addresses.
• You can search for devices on the same segment by putting a
check in [Search Local Subnets].
• If searching for individual printers you can add the IP address
of the printer you are searching for.

6
Configuration Tool

④④ Printers connected to the network are found, and select the
printer you want to configure from the list.
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• Configure printer network settings

①① Refer to the IP address or the MAC address from the list, and

④④ Enter the password in [Password] and then click [OK].

select the printer you would like to configure.

Memo
Memo

• The MAC address will be displayed in Network Information.
(Setup Instructions)
• For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be
displayed.

②② Click the

[Device Settings] icon.

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
• When entering the password, [●●●●●●] will be displayed on the
screen.
• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

⑤⑤ Configure the details you entered in ③ on the printer, and register them on the Configuration Tool.

•W
 hen registration on the Configuration Tool is finished, the following message will be displayed.

6

③③ Enter the required items and click on [OK].
• If the configured printer has already been registered in Config-

Configuration Tool

uration Tool, the following message will be displayed, and just
update Configuration Tool information.
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⑥⑥ Click on [OK] to initiate restarting of the printer, and the
configured printer status will turn
(Green)).

(Red) (it is normally

③③ Put a check in [Device Settings(Web)-Enable] and click on [OK].

⑦⑦ When restarting of the printer has finished, the configured
printer status will turn

(Green).

• Configure web settings

①① Refer to the IP address or the MAC address from the list, and
select the printer you would like to configure.

Memo

• The MAC address will be displayed in Network Information.
(Setup Instructions)
• For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be displayed.

[Device Settings] icon.

Memo

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
• When entering the password [●●●●●●] will be displayed on the
screen.
• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

⑤⑤ If you configured the settings correctly, the following screen
will be displayed.

101

6
Configuration Tool

②② Click the

④④ Enter the password in [Password] and then click [OK].

Chapter 6 Useful Utilities (Windows)

⑥⑥ Click on [OK] to initiate restarting of the printer, and the
configured printer status will turn
(Green)).

(Red) (it is normally

⑦⑦ When restarting of the printer has finished, the configured
printer status will turn

(Green).

• Display the webpage

①① You can display the webpage for the selected printer by clicking the

6
Configuration Tool
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[Display Web Page].

• Change network password

①① Refer to the IP address or the MAC address from the list, and
select the printer you would like to configure.

Memo

•T
 he MAC address will be displayed in Network Information.
(Setup Instructions)
••For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP] . If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be
displayed.

②② Click the

[Change Password] icon.

③③ Enter the current password and new password and click [OK].

• Change the order in which printer information is displayed
By clicking on the following fields, the information will be reordered based on the values in each of the fields you click: Status,
Device Name, IP Acquisition Method, IP Address, MAC Address,
Subnet Mask, Defaut Gateway, Network Card Setup Model Name,
Network Card Setup Program Version, Device Web Page Enable/
Disable.

Memo

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
• When entering the password, [●●●●●●] will be displayed on
the screen.
• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

④④ If you configured the settings correctly, the following screen
will be displayed.

6
Configuration Tool
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Oki Storage Device Manager
This is a utility for configuring printer flash memory settings, and
registering and deleting form data.
Note!

• OKI Storage Device Manager is stored on the Software DVD ROM.

Operating environment

③③ Select [Print] from the [File] menu.
If you are using a PCL print driver, move to ⑦ .

④④ Click on [Preferences].

⑤⑤ Click [Overlay] in the [Job Options] tab, and select [Create
Form].

Computers running Windows 8.1/Windows 8/Windows Server
2012/Windows Server 2012 R2/Windows 7/Windows Vista/
Windows Server 2008/Windows Server 2008 R2/Windows XP/
Windows Server 2003
Having InternetExplorer 6.0 or higher installed
Install

①① Set the Software DVD - ROM in the drive.

6

Main methods of use

Oki Storage Device Manager

• Launching the Utility

①① Select [Start] - [All Programs] - [Okidata] - [Oki Storage Device Manager] - [Oki Storage Device Manager].

• Registering Form

①① Make [Ports] into [FILE:].

 Output Print Data to File (P 64)
②② Launch the application, and create the form which you want to
register on the printer.
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⑥⑥ Click [OK] twice and click [Print].

⑦⑦ Enter the file save name and select the destination to save to.
⑧⑧ Restore the [Ports].
⑨⑨ Launch the Oki Storage Device Manager.

a connected port on the [SDM - Printer Discovery]

⑩⑩ Select
screen, and click [Start].

⑪⑪ Click [Exit].

⑫⑫ Select [New Project] from the [Projects] menu.

[Add File to Project] from the [Projects] menu, and se
⑬⑬ Select
lect select the created form.

The form file is added to the project.

• Check the Free Space in SD Memory Cards (Optional) or or Flash Memory

①① Launch the Oki Storage Device Manager.

 Launching (P 104)
②② On the [SDM - Printer Discovery] screen, select the port connected to the printer and click [Start].

③③ Click [Exit].

④④ Select the printer in the lower window and select [Show Resource] from the [Printers] menu.

⑭⑭ Double click on the form file added to the project, enter a
number of your choice into [ID], and then click [OK].

Memo

• When using the Windows PS printer driver, enter [Name].

Note!

• When using a PS printer driver and if an SD memory card is
inserted, change the volume from "%disk0%" to "%flash0%".
In other cases do not change the volume name or password.

⑤⑤ In the case of using an SD memory card select [SD0] and in
the cash of flash memory, select [FLASH0].

Memo

• If there is no SD memory card inserted, [SD0] will not be displayed.

⑥⑥ Select [Details] from the [View] menu.

6
Oki Storage Device Manager

the lower window, and select [Send Project Files to

⑮⑮ Select

Printer] from the [Projects] menu. The form file is registered
on the printer.

⑯⑯ On the completion screen, click on [OK].
⑰⑰ Close the Oki Storage Device Manager.
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⑦⑦ The partition type will be displayed in the Usage filed, and the

partition free space will be displayed in the Free Space field, in
units of Bytes.

Memo

⑦⑦ Select the flash partition from the list, and click [Entire Flash
Memory].

• [PS] and [MIX] are displayed separately, however they indicate the same partition.

• Free up space in an SD memory card or flash drive

①① Launch the Oki Storage Device Manager.

 Launching (P 104)
②② On the [SDM - Printer Discovery] screen, select the port con-

⑧⑧ Click [Yes] on the initialization confirmation screen.

③③ Click [Exit].

⑩⑩ On the completion screen, click on [OK].

nected to the printer and click [Start].

6

④④ Select the printer from the lower window. Select [Administrator
Functions] from the [Printers] menu.

⑤⑤ Enter the administrator password in [Enter Password].

Oki Storage Device Manager

Memo

• The default administrator password is "PASSWORD".

⑥⑥ Click on [Initialise Flie System [FORMAT Volume(s)]].
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⑨⑨ On the shutdown confirmation screen, click on [OK].
⑪⑪ Turn the printer power OFF ( ◯ ) /ON ( l ).

 Turning Off the Power (Setup Instructions)

• Initializing Flash Memory

①① Launch the Oki Storage Device Manager.

 Launching (P 104)

 initializing, click on [Entire Flash Memory].
⑦⑦ If

If formatting a particular partition, select the partition you
want to format from the list, and click [Format Partition].

②② On the [SDM - Printer Discovery] screen, select the port connected to the printer and click [Start].

③③ Click [Exit].

④④ Select the printer in the lower window and select [Administrator
Functions] from the [Printers] menu.

⑤⑤ Enter the administrator password in [Enter Password].
Memo

• The default administrator password is "PASSWORD".

⑥⑥ Click on [Initialise Flie System [FORMAT Volume(s)]].

⑧⑧ Click [Yes] on the initialization confirmation screen.

⑨⑨ On the shutdown confirmation screen, click on [Yes].
⑩⑩ On the completion screen, click on [OK].

⑪⑪ Turn the printer power OFF ( ◯ ) /ON ( l ).

 Turning Off the Power (Setup Instructions)

6
Oki Storage Device Manager
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• Initializing an SD memory card

①① Launch the Oki Storage Device Manager.

 Launching (P 104)
②② On the [SDM - Printer Discovery] screen, select the port connected to the printer and click [Start].

③③ Click [Exit].

⑦⑦ If initializing, click on [Entire HDD/SD].
If formatting a particular partition, select the partition you
want to format from the list, and click [Format Partition].
If you want to change the purpose of use of a partition, select
the partition you want to format, select the partition type from
[Volume Type] and click [Format Partition].

④④ Select the printer in the lower window and select [Administrator
Functions] from the [Printers] menu.

⑤⑤ Enter the administrator password in [Enter Password].
Memo

• The default administrator password is "PASSWORD".

⑥⑥ Click on [Initialise Flie System [FORMAT Volume(s)]].

6

⑧⑧ Click [Yes] on the initialization confirmation screen.

⑨⑨ On the shutdown confirmation screen, click on [Yes].

Oki Storage Device Manager

⑩⑩ On the completion screen, click on [OK].

⑪⑪ Turn the printer power OFF ( ◯ ) /ON ( l ).

 Turning Off the Power (Setup Instructions)
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PS Gamma Adjuster
You can adjuster the printer half - tone density and the print density
of photos.
Note!

• The printing speed may be slow if halftone adjustment is used. If
you want to prioritize the speed, select [Not Specified ] from [Half Tone Adjustment].
• Depending on the application, the Dot Gain Correction or Half
- Tone Adjustment may be set at the time of printing, or those
functions may be included in the EPS file. If using this kind of
function on the application side, select [Not Specified] in [Half
- Tone Adjustment].

Operating environment

③③ Select [OKI B840], and click [Next].

④④ Read the [Software License Agreement], and click [I Agree].
⑤⑤ Click [Optional Software].

Computers running Windows 8.1/Windows 8/Windows 7/Windows
Vista/Windows XP/Windows Server 2012/Windows Server 2012 R2/
Windows Server 2008/Windows Server 2008 R2/Windows Server
2003

Note!

6

• For setup, computer administrator rights are required.

①① Turn the printer power ON ( l ).

PS Gamma Adjuster

Install

⑥⑥ Click [PS Gamma Adjuster].

②② Check that Windows is launching and set the Software DVD ROM in the drive.

The setup program will launch.
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⑦⑦ Click [Next].

⑧⑧ Check the destination to install to and click [Next].
⑨⑨ Check the program folder name and click [Next].
⑩⑩ Click [Finish].

③③ Click on [New].
④④ Adjuster the half - tone with any of the following methods, enter
the name into [Gamma Curve Name], and then click [OK].

Memo

Main methods of use
• Launching the Utility

①① Select [Start] - [All Programs] - [Okidata] - [PS Gamma
Adjuster].

• Directly carry out operations to graph lines.
You can drag and click on lines.Perform an adjustment by
moving the control point.
••Enter the gamma value.
Enter the gamma value and click on [Gamma Setting]. A
smooth curve is automatically created with 13 points and
half - tones are adjusted. You can set a value between 0.01
and 99.99. Values greater than 1.0 are weaker half - tones,
smaller values are stronger.
••Enter values into each density textbox.

• Adjuster the printing density of photographs

①① Launch the PS Gamma Adjuster.
②② Select the machine from [Select Printer].

6
PS Gamma Adjuster

⑤⑤ Click [Add].

The half - tone adjustment name is displayed in [Printer’s
Gamma Curve:] within [Printer].

Memo
Memo
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• Depending on the application (such as Adobe PageMaker),
there may be an independently prepared PPD file used at the
time of printing. In such a case, click [Select PPD for Application], click [Browse] and select the PPD file used by the application.

• The model name will be displayed in the [Select Printer] list.
If there are multiple printers of the same type in the [Printers
and Faxes] folder, the registered [Gamma Curve Name] will be
enabled for all printers of the same model.

⑥⑥ Click on [Apply].
Memo

• A maximum of 6 [Printer’s Gamma Curves:] can be registered
in one PPD file.

⑬⑬ Select the [Gamma Curve Name] created in

from within [Cus-

tom Gamma Adjustment], and then print.

⑦⑦ Click on [OK] on the PPD registration completion screen.
⑧⑧ Click on [Exit] to close the PS Gamma Adjuster.
Note!

• After registering the [Gamma Curve Name], the [Custom Gamma
Adjustment] menu or its contents may not be displayed within
the [Paper/ Quality] tab. In this case, restart your computer.
• Before printing, restart applications that were launched prior to
having registered a [Gamma Curve Name].

⑨⑨ Open the file you want to print.

6

⑩⑩ Select [Print] on the [File] menu.

PS Gamma Adjuster

on [Preferences].

⑪⑪ Click

⑫⑫ Select the [Custom Gamma Adjustment] check box in the [Job
Options].
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Deleting Utilities
• If you are using Windows 7/Windows Vista/Windows Server 2008

①① Select [Start] - [Control Panel], and click on [Uninstall a program].

②② Select the utility to delete and click on [Uninstall].

③③ If [User Account Controls] is displayed, click [Continue].
④④ Delete them on the screen.

• If you are using Windows XP/Windows Server 2003

①① Select [Start] - [Control Panel], and click on [Add or Remove
Programs].

②② Select the utility you want to remove and click [Remove].
③③ Delete them by following the screen.

6
Deleting Utilities
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Explanation of Utilities
We explain here utilities that make the Macintosh environment you
are using more convenient.

Explanation of Utilities

7

Model
Operating
supported environment

Storage
location

Utility Name

Function

Web browser

You can configure the B840
printer network settings B820
and menu settings.

Mac OS X

PS Gamma
Adjuster

Yo u c a n a d j u s t e r t h e B840
printer half - tone density
and the print density of
photos.

Mac OS X Software
DVD-ROM

Network Card
Setup

You can configure printer B840
network settings or display B820
the web browser.

Mac OS X Software
DVD-ROM

TELNET

You can use TELNET to set B840
printer network settings. B820

Mac OS X

Print Job
Accounting
Client

Set user name and user B840
ID on printer driver.

Mac OS X Software
DVD-ROM

114

Reference
page

121

115

181

184

PS Gamma Adjuster
You can adjuster the printer half - tone density and the print density
of photos.
Note!

• The printing speed may be slow if halftone adjustment is used. If
you want to prioritize the speed, select [None] from [Adjuster Halftone].
• Depending on the application, the Dot Gain Correction or Half
- Tone Adjustment may be set at the time of printing, or those
functions may be included in the EPS file. If using this kind
of function on the application side, select [None] in [Adjuster
Halftone].

Operating environment
Running of the Mac OS X 10.6.8

④④ Adjuster the half - tone with any of the following methods, enter
the name into [Gamma Curve Name], and then click [Save].

Memo

• Directly carry out operations to graph lines.
You can drag and click on lines. Perform an adjustment by
moving the control point.
• Enter the gamma value.
Enter the gamma value and click on [Gamma Setting]. A
smooth curve is automatically created with 13 points and
half - tones are adjusted. You can set a value between 0.01
and 99.99. Values greater than 1.0 are weaker half - tones,
smaller values are stronger.
• Enter values into each density textbox.

10.9 of Macintosh
PS Gamma Adjuster

Main methods of use
• Adjuster the printing density of photographs

①① Set the Software DVD - ROM in the drive.

②② Click on the [Utility] - [Halftone] - [PS Gamma Adjuster] tab.

⑤⑤ Confirm that the PPD file with the half - tone adjustment registered is selected.

If a different PPD file is selected, click [Select PPD], and select
the target PPD file.

③③ Click on [New].

⑥⑥ Click [Add].

The new half - tone adjustment name is displayed in the registration list on the right.

115
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⑦⑦ Click on [Save]. If the Authentication screen is displayed, enter
the username and password of the administrator.

Register the Half - Tone Adjustment name displayed in the
registered list, into the PPD file.

⑧⑧ Exit the PS Gamma Adjuster utility.

⑨⑨ Delete and reregister the printer on which to carry out the half
- tone adjustment registered in [Printer Setting Utility].

Memo

• Do not click the [Configure] button when adding a printer.

PS Gamma Adjuster

• If a dialogue to select printer options appears when adding a
printer, click [Cancel], and re-add the printer.

⑩⑩ Open the file you want to print.

⑪⑪ Select [Print] from the [File] menu.

⑫⑫ Select the [Gamma Curve Name], created in procedure ③ from
[Custom gamma] in the [Job Option] function set within the
[Printer Features] panel.

7

116

Chapter 8 Regarding Networks
Initializing Network Settings…………………………………………………………118
Using SNMP……………………………………………………………………………………118
Using IPv6… …………………………………………………………………………………119
Web browser (Common to Windows/ Macintosh)… ……………………121
OKI LPR Utility (only for Windows)………………………………………………165
Network Extension (only for Windows) ………………………………………173
Network Card Setup (only for Windows) ……………………………………176
Network Card Setup (only for Macintosh) … ………………………………181
TELNET (Common to Windows/ Mac OS X) … ……………………………184

Note!

• In this chapter, [WordPad] is used as a an example for Windows and [Text Editor] for Mac OS X.
• The screen or procedure may vary depending on the applicaiton you use.
• Please refer to Online Help for detailed explainations of each setting item for printer drivers and utilities.
• The details may differ from those in this manual if you upgrade the version of printer driver or utility you are using.
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Initializing Network Settings
Changes all network setting items to initial values.

The SNMP agent is available. You can refer to/ change the printer set
value with a commercially-available SNMP manager.

①① Check that [Online] is displayed on the control panel.
②② Press the

or

button several times. [Network Menu]

will be displayed, and press the

③③ Press the

or

ENTER button.

button several times. [Default Settings/

Enable] will be displayed, and press the
Initializing Network Settings\Using SNMP

8
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Using SNMP

ENTER button.

The setting items that can be referred to/ changed with an SNMP
manager are called MIB, and B820n/B840dn support MIB-II as
well as Oki Data Private MIB. Regarding the Oki Data Private MIB,
please refer to "Readme-j.txt" within the [MISC]-[Mib] folder on the
Software DVD-ROM.

Using IPv6
The IPv6 function is available.
The IPv6 adress is automatically acquired, and it is not required to
set it manually.

Protocol
FTP

Application
Windows 7
Windows Vista

The following protocols are supported with IPv6.

Windows XP
Command
prompt FTP

Printing: LPD, Port9100, IPP, FTP
Setting: HTTP, Telnet, SNMPv1/v3

Mac OS X

Sending SMTP, IP filtering, WINS registration, and SNMP Trap, etc.
only support IPv4.

FTP from a
terminal

The applications that have been changed to work normally are as
shown in the following table.
Note!

Protocol
LPD

• If using IPv6 with Windows XP, IPv6 will need to be installed
separately.
Application
Windows 7
Windows XP
Command
Prompt LPR

Port9100

Windows 7
Windows Vista

(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.

(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.

 owever, if setting by only enabling IPv6
Redhat Linux 9.0 (2) H
through Telnet, you will not be able to set
LPRng
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").
(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.
(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

HTTP

Windows XP

(1) For hosts file editing, or accessing through
the DNS server, you can set the host name.
Internet Exploler
6.0
(2) However, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.

Windows 7

(1) IPv6 addresses need to be entered within “[]”.

Windows Vista

(2) F
 or hosts file editing, or accessing through
the DNS server, you can set the host
name.

Windows XP
Mozilla Firefox
(Ver.2.0)

(3) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(4) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").
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Windows Vista

Conditions of Use

Conditions of Use
(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.

8
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Protocol
HTTP

Application
Mac OS X
Safari
(1.2.3-v125.9)

Conditions of Use
(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.
(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

Mac OS X

(1) IPv6 addresses need to be entered within “[]”.

Safari

(2) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.

(2.0-v412.2)

(3) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(4) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").

Telnet

Windows 7
Windows Vista
Windows XP
Command
Protocol Telnet

Using IPv6

Mac OS X
Telnet from a
Terminal

8

(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.
(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").
(1) F
 or hosts file editing, or accessing through
the DNS server, you can set the host name.
(2) H
 owever, if setting by only enabling IPv6
through Telnet, you will not be able to set
a host name through using a DNS server.
(3) A
 lso, you cannot specify the host name for
connections specified with the link local
address (addresses starting with "fe80").
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Web browser

(Common to Windows/ Macintosh)

You can configure the printer network settings and menu settings.
Operating environment
For those using Windows
Computers with Microsoft Internet Explorer Ver6.0 or higher, or
FireFox Ver3.0 or higher installed computer.
A computer operating with TCP/IP
• Check whether your browser settings are as shown below.
•• Set [Internet Options] - [Privacy] - [Settings] within the [Tools]
menu to [Medium].

①① Launch a web browser.

②② Enter "http://(printer's IP address)" in the address bar and
press the Enter key.

Note!

• I f the IP address includes a 1- or 2-digit number value, please
enter "0" at the front of the number value. It may be not
possible to carry out communication.
(E.g.) Correctly-entered value: http://192.168.0.2/
Incorrectly-entered value: http://192.168.000.002/

For those using a Mac OS X
Computers with Safari Ver2.0 or higher, or FireFox Ver3.0 or
higher installed Computer

Display the printer status.

A computer operating with TCP/IP
Main methods of use
This explaination uses the following environment as an example.
Printer

: B840dn

Printer IP address : 192.168.0.2
MAC address : 00:80:87:62:CA:B3

8

Web browser : Microsoft Internet Explorer Ver.6.0
Memo

Web browser (Common to Windows/ Macintosh)

Memo

•• Launch/ Check print status

• You can display your MAC address by launching your web
browser and clicking [Print Information].
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•• Log in as the administrator

①① Launch a web browser.
Launching (P 121)

②② Click [Administrator Login].

Web browser (Common to Windows/ Macintosh)

③③ Enter [root] into [User] and enter [The Current Password] into
[Password], and click [OK].

Memo

8
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• The default password is "aaaaaa".

④④ Configure the printer information that can be checked on the
network, and click [OK] or [SKIP].

Memo

• I f you click [SKIP], the configuration of settings is shorter.
Put a check into [Do not show this page again.], and click [OK]
or [SKIP], to not display it from next time.

⑤⑤ The following screen will be displayed.

•• Changing the Password

You can change the password used at the time of logging in as the
administrator.

④④ Enter a new password into [New Admin Password], and reenter
it into [Verity Admin Password].

Note!

①① Log in as the administrator.
Logging in as the Administrator (P 122)

②② Click the [Security] tab.

• When entering the password [●●●●●●] will be displayed on the
screen.
•• Enter 6-12 alphanumeric characters for the password.
•• When entering the password, please make sure that you enter
upper and lower-case letters correctly.

③③ Click [Change Admin Password].

⑥⑥ The values set in the printer are saved and the network

function is restarted.
The new password will be enabled from the next time you
change settings. You do not need to turn the printer power OFF
( )/ON ( ).

Note!

• This password will differ to TELNET and [Network Setting] for
Configuration Tool.

123

Web browser (Common to Windows/ Macintosh)

⑤⑤ Click on [Submit].

8
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•• Changing Printer Settings

①① Log in as the administrator.

④④ Click on [Submit] when you have finished changing the
settings.

Logging in as the Administrator (P 122)

②② Click the [Printer] tab.

Web browser (Common to Windows/ Macintosh)

•• Encrypting communication (SSL/TLS)

This encrypts settings configured through a website and
communication between the computer (client) and the printer at
the time of IPP printing (encryption of communicaiton through
HTTPS).

③③ Click on the items you want to change.

The item details are displayed in the right frame. Click on the
item you want to change.

Method of Configuration
The encryption setting tools are as shown below.
1) Website
2) O
 nly TELNET (Stength of encryption (weak/ standard/
strong) and turning SSL/TLS (Encryption) ON/OFF
(enabling/ disabling) can be changed).
The configuration process
If using the web, the procedure for creating a certificate with
the printer is displayed.
The following two types of certificates can be created.
1) Self-signed certificate
2) Certificate signed by a certification authority (create CSR)

8

Note!
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• I f the printer's IP address is changed from the time of creating
the certificate, the certificate will be invalidated. Please do not
change the printer's IP address after creating the certificate.

Procedure for creating the certificate

④④ Set [SSL/TLS] in [STEP 1] to [Enable].

①① Log in as the administrator.
Logging in as the Administra tor (P 122)

②② Click the [Security] tab.

③③ Click on [SSL/TLS].

•P
 lease set the encryption strength to [Standard] in normal
situations. If you want to change the strength of the
encryption, click on [Clpher Level Setting] and change the [SSL/
TLS] value.

Web browser (Common to Windows/ Macintosh)

Memo

8
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⑤⑤ Enter items such as Common Name and Organization In normal
situations, please use the Key Exchange Method and Key Size
as the are initially, without changing them (RSA, 1024bit). If
you want to change it, lick [Change these settings].

Memo


input details will be displayed. Check the details and click [OK].
⑦⑦ The
Creates a certificate.

• I f you selected [Using a Certiﬁcate which a Certiﬁcation
Authority signed], please follow the certification procedure
of the certification authority for the method of issuing the
certificate for the input details, etc.

Web browser (Common to Windows/ Macintosh)

With this the creation of a self-signed certificate is completed.
For a certificate issued by a certificating authority, you need to
then follow the procedure below.

⑥⑥ Click [OK].

⑧⑧ Remove the CSR and send to the certificating authority.

Copy the contents of the text box from "----- BEGIN
CERTIFICATE REQUEST -----" to "----- END CERTIFICATE
REQUEST -----". The CSR may use the following methods to
send it include: pasting onto a website, sendnig as a file, or
attaching to a email file.

8
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⑨⑨ Click on [OK].

Methods of Use

①① Launch a web browser and enter "https://Printer IP Address" in
the address bar, to connect.

⑩⑩ Use the web to install the certificate issued by the certificating

Environment
Usable OS

Web browser (Common to Windows/ Macintosh)

authority.

•• Printing (IPP Print)

Windows 8.1, Windows Server 2012 R2,

			

Windows 8, Windows Server 2012,

			

Windows 7, Windows Server 2008,

			

Windows Server 2008 R2,

			

Windows Vista, Windows XP,

			

Windows Server 2003

①① Turn the computer power ON and launch Windows.
⑪⑪ Follow 1-4 to display the encryption (SSL/TLS) setting screen.
Paste from "----- BEGIN CERTIFICATE -----" to "----- END
CERTIFICATE -----" into the textbox, and click [Send].
With this the creation of the certification authority issued
certificate is completed.

②② Launch your web browser and log in as the administrator.
Set the [IPP] network tab to [Enable].

Logging in as the Administrator (P 122)

③③ Add a printer.

<For Windows 8.1/Windows Server 2012 R2>
Select [Control Panel] - [Hardware and Sound] - [Devices and
Printers].

8

<For Windows 8/Windows Server 2012>
Select [Control Panel] - [Hardware and Sound] - [Devices and
Printers].
<For Windows 7 /Windows Server 2008 R2>
Select [Start] - [Devices and Printers]. Click [Add a Printer].
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<For Windows Vista /Windows Server 2008>
Click [Start]-[Control Panel]-[Printer]. Click [Install Printer].

⑥⑥ Click on [

The printer that i want isn't listed].

<For Windows XP>
Select [Start] - [Control Panel], and click on [Printers and Other
Hardware].
Click [Printers and Faxes] in [or pick a Control Panel icon].
Click [Printer Tasks] - [Install a Printer].
<For Windows Server 2003>
Click [Start] - [Printers & Faxes].
Double click on [Add a Printer].

⑦⑦ Select [Select a shared printer by name], enter [http://

Web browser (Common to Windows/ Macintosh)

Printer's IP Address/ipp] or [http://Printer's IP Address/ipp/lp],
and click on [Next].

④④ Click on [Next] on the [Printer Addition Wizard] screen.

⑤⑤ Select [Add a Network, Wireless or Bluetooth Printer], and click
on [Next].

8
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⑧⑧ Click [Have Disk].

⑨⑨ Set the Software DVD-ROM in the drive.

⑩⑩ Enter the following into [Source to Copy Manufacturer Source

⑫⑫ Click on [Next].

File] and click [OK].

If installing a PS printer driver.
D:\Drivers\ENU\PS
If installing a PCL printer driver.
D:\Drivers\ENU\PCL

⑬⑬ If setting the printer that you normally use, put a check in it

Memo

• I f printing from a PostScript-compatible application (such as
Adobe Illustrator), select a PS driver.
•• If printing from another application, you can select either.

⑪⑪ Select the printer name and click [Next].

⑭⑭ Select the printer icon and right-click on [Printer Properties] to
open it.

Web browser (Common to Windows/ Macintosh)

and click [Finish].

8
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⑮⑮ Click on [Print Test Page].

•• Encrypting communication (IPSec)

You can encrypt communication between the computer and printer
and prevent tampering on the network layer leve.

Memo

• The IKE protocol supported by this printer is [IKEv1].
• The communication mode supported for this printer is
[Transport Mode]. [Tunnel Mode] does not work.
• If IPSec is enabled, the response of the equipment may be
slow depending on the network communication status.
• If IPSec is enabled, it is recommended to not run multiple
operations such as network printing from multiple computers.

Web browser (Common to Windows/ Macintosh)

Method of Configuration
If the Menu map was printed, setup is complete.

⑯⑯ Open the file you want to print.
⑰⑰ Select [File] – [Print], set the created IPP printer and print.

Configure the settings for the computer after configuring the
printer.
Device settings
Displays the procedure for enabling IPSec by using the web.

①① Log in as the administrator.
Logging in as the Administrator (P 122)

8
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②② Click the [Security] tab.

④④ Enable [IPSec] in [STEP1].
Note!

• If you set IPSec to [Enable], access will not be possible from
any computer other than that with the IP address set in [Step
2].
•• If IPSec setting fails due to reasons such as the set value
not matching the cmoputer, you will not be able to open the
website. In such a case, disable IPSec by disabling the [IPSec]
wetwork setting item on the control pannel, or by initializing
the network.

③③ Click the [IPSec] tab.
Web browser (Common to Windows/ Macintosh)

8
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⑤⑤ Enter the host IP address in [STEP2].
Note!

Web browser (Common to Windows/ Macintosh)

8
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• Using the IP address, set a host for which printing/setting
configurations is permitted.
•• Please use half-byte numerical characters separated by "." for
the IPv4 address.
•• Please use half-byte numerical characters separated by ":" for
the IPv6 address.
•• IPv6 link local addresses are not supported.
•• If you enter 0.0.0.0 for the IP address, it will be disabled.

⑥⑥ Set each Phase1 Proposal in [STEP3].

Select from between 3DES-CBC and DES-CBC in [IKE
Encryption Algorithm] to set it.
Select from between SHA-1 and MD5 in [IKE Hash Algorithm].
Select between Group2 and Group1in [Diffie-Hellman Group].
Enter between 600 (Secs) - 86400 (Secs) in [LifeTime] to set it.

⑦⑦ Set the pre-shared key in [STEP4].

Enter between 1 and a maximum of 64 half-sized assets in
[Pre-Shared Key]. Here we use the example of entering [ipsec]
in the character string.

If you select [Key PFS], set the following items.
Select between Group2 and Group1 for [Key PFS Difﬁe-Hellman
Group] to set it.

Web browser (Common to Windows/ Macintosh)

⑧⑧ Set the Key PFS in [STEP5].

Select between KEYPFS and NOPFS in [Key PFS] to set it.

8
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⑨⑨ Set Phase 2 Proposal in [STEP6].

⑩⑩ Click [Submit].

Select between Enable and Disable for [ESP] to set it.
Set the following items if [ESP] is set to enabled.
Select from between 3DES-CBC and DES-CBC in [ESP Encryption
Algorithm] to set it.
Select from between SHA-1, MD5, and OFF in [ESP Authentication
Algorithm]. If you select OFF, the ESP authentication algorithm will
not be applied.
Select between Enable and Disable for [AH] to set it.
Web browser (Common to Windows/ Macintosh)

Set the following items if [AH] is set to enabled.
Select from between SHA-1 and MD5 in [AH Authentication
Algorithm].
Enter between 600 (Secs) - 86400 (Secs) in [Life Time] to set
it.

⑪⑪ The values set in the printer are saved and the network
function is restarted.

•• Computer settings

The following explaination uses Windows 7 as an example.

①① Click on [Administrative Tools] in [Control Panel].

8

Note!
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• Set either or both of [ESP] and [AH] to enabled.

②② Double-click on [Local Security Policy].

⑥⑥ Enter the name as well as the explaination of this IP security
policy created in [Description], and then click [Next].

③③ Click on [IP Security Policies on Local Computer].

and click on [Next].

④④ Select [Create IP Security Policy] from the [Action] menu.

⑧⑧ Select [Edit Properties] and then click [Finish].
⑤⑤ Click on [Next].

Web browser (Common to Windows/ Macintosh)

⑦⑦ Remove the check from [Activate the default response rule],

8
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Web browser (Common to Windows/ Macintosh)

⑨⑨ Click the [General] tab.

⑫⑫ Click [Methods].

⑩⑩ Click [Settings].

⑬⑬ Click [Add].

⑪⑪ Enter the same time as for the lifetime of Phase1 Proposal

in [Equipment Settings],
(P 134), in units of minutes in
[Authenticate and generate a new key after every:] (units of
minutes).

Memo

8
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• [Life time] in Phase1 Proposal is in units of seconds, but here
units are in minutes.

⑭⑭ Add details to Phase1 Proposal in [Securty method preference
order], and click [OK].

⑮⑮ On the [Key Exchange Security Methods] screen, click [OK].
Memo

⑱⑱ Click [Add].

• You can delete the security methods other than those you
added.

⑰⑰ On the [New IP Security Policy Properties] screen click the
[Rules] tab.

⑲⑲ Click on [Next].

⑳⑳ Check that [This rule does not specify a tunnel] is selected on
the [tunnel endpoint] screen, and click [Next].

Web browser (Common to Windows/ Macintosh)

⑯⑯ On the [Key Exchange Settings] screen, click [OK].

8
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㉑ Check that [All network connections] is selected on the [Select
the network type] screen, and click [Next].

Web browser (Common to Windows/ Macintosh)

㉒ Click on [Add].

㉓ Click on [Add].

8
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㉔ Click on [Next].

㉕ Enter the IP folder name or explaination, and click [Next].

 Select [Source address], and click [Next].

㉚ Click [OK].

㉘ Click [Next].

㉛ Select the created IP filter, and click [Next].

㉙ Click [Finish].

Web browser (Common to Windows/ Macintosh)

㉗ Click [Next].

㉜ Click [Add].

8
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㉝ Click on [Next].

㊱ Click on [Next].

㉞ Click on [Next].

㊲ Select [Custom] on the [IP Traffic Security] screen and click

Web browser (Common to Windows/ Macintosh)

㉟ Click on [Next].

[Settings].

㊳ Match the [Equipment Settings]details set in
Phase2 Proposal and click [OK].

8
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. (P 134)

㊴ Click on [Next].

㊵ Remove the check from [Edit Properties], and click on [Finish].

㊷ Select the created filter, and click [Next].

key)], enter the character string, and then click [Next].

㊶ If Key PFS is enabled, remove the check from [Use session key
perfect forward secrecy (PFS)], and click [OK].

㊹ Click [Finish].

Web browser (Common to Windows/ Macintosh)

㊸ Select [Use this string to protect the key exchange(preshared

8

Note!

• You must put a check in [Accept unsecured communication,
but always respond using IPsec], if you perform IPSec
communication using the IPv6 global address.
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㊺ Click [OK] on the [New IP Security Policy Properties] screen.

•• Use restricted access function (IP filter)

Use an IP address to manage printer access.
Memo

• In the initial printer settings, [IP filter] is set to [Disable].

Note!

• If there is a mistake in entering the IP address, it will not
be possible to access printers using IP protocol. Please pay
sufficient attention to this.

Method of Configuration

①① Log in as the administrator.
Web browser (Common to Windows/ Macintosh)

Logging in as the Administrator (P 122)

㊻ Select the created new IP security policy, and select [Assign]
from the [Action] menu.

㊼ Check that the created new IP security policy's [Policy
Assigned] is set to [Yes].

8
㊽ Click on
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on the top right of the screen, and close the screen.

②② Click the [Security] tab.

③③ Click on [IP Filtering].

Note!

• If IP filtering is set to [Enable], all access from hosts with IP
addresses outside the range set in [STEP2] will not be possible.

Note!

• If you enter 0.0.0.0 for the IP address, it will be disabled.

Memo

• Using the IP address, enter a range of hosts for which printing/
setting configurations is permitted.
•• Please use half-byte numerical characters separated by "." for
the IP address.
•• If there are overlapping IP address ranges, the adress range
set to have a high [Priority Level] will be prioritized.
•• Regardless of that set in step 2, administrator addresses for
which printing/configuring of settings is possible are set in
Step 3.
Web browser (Common to Windows/ Macintosh)

④④ In [STEP1], set [IP Filtering] to [Enable].

⑤⑤ Set the IP address in [STEP2].

⑥⑥ Click the [Address Range Bar Display/Refresh] button.

If you want to correct the IP address range, reenter the
relevant IP address and then click on [Address Range Bar
Display/Refresh].

8
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⑦⑦ Set the value in [Administrator's IP Address setting] in [STEP 3].

Web browser (Common to Windows/ Macintosh)

By entering the administrator's IP address in [Administrator's
IP Address setting], in the unlikely case that incorrect settings
were entered in [STEP2], the administrator can reset them
from the host with the IP address set in [Administrator's IP
Address setting].
Note!

8
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• If accessing the printer through a proxy, etc., the address of the
machine through which the connection is made will be displayed
as [Your Current Local Host/Proxy IP Address ]. Therefore,
your host address may differ from the address shown in [Your
Current Local Host/Proxy IP Address].
•• If nothing is registered for [Administrator's IP Address
setting], based on Step 2, it will be completely impossible to
access the printer.
•• If you do not want to access the administrator IP address,
leave the [Administrator's IP Address setting] field blank.

⑧⑧ Click [Submit].

⑨⑨ The values set in the printer are saved and the network function
is restarted.

•• Control access with the MAC address

③③ Click on [MAC Address Filtering].

Use an MAC address to manage printer access.
Note!

• If there is a mistake with the MAC address, it will be impossible
to access the printer using the network. Please sufficient care
with this.

Method of Configuration

①① Log in as the administrator.
Logging in as the Administrator (P 122)

④④ In [STEP1], set [Select MAC Address Filtering Settings] to [Enable].

Web browser (Common to Windows/ Macintosh)

②② Click [Security] tab.

8
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⑤⑤ Select whether to [Accept (Deny)] communication from the
MAC address specified in [STEP2].

Web browser (Common to Windows/ Macintosh)

Memo

8
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• Using the MAC address, enter a host MAC address for which
communication is permitted (rejected).
•• Please use half-byte numerical characters separated by ":" for
the MAC address.
•• Regardless of that set in STEP2, administrator addresses for
which communication is possible are set in STEP3.

⑥⑥ Set the value in [Administrator's MAC Address setting] in [STEP3].

By entering the administrator's MAC address in [Administrator's
MAC Address setting], in the unlikely case that incorrect
settings were entered in [STEP2], the administrator can
reset them from the host with the MAC address set in
[Administrator's MAC Address setting].
Note!

• If accessing the printer through a proxy, etc., [Your Current
Local Host / Proxy MAC Address] will appear as the machine
through which the MAC address. Therefore, your host address
may differ from the address shown in [Your Current Local Host
/ Proxy MAC Address].
•• If nothing is registered for [Administrator's MAC Address
setting], based on Step 2, it will be completely impossible to
access the printer.
•• If you do not want to access the administrator MAC address,
enter 00:00:00:00:00:00 in the [Administrator's MAC Address
setting] field.

⑦⑦ Click [Submit].

•• Use the mail sending funtion (SMTP)

The mail sending funtion (SMTP) is available. You can have a mail
sent when errors occur with the printer. You can select setting to
have regular messages sent saying whether errors are occuring,
or to have a mail sent at the time when an error occurs.
Setting emails to be sent

①① Log in as the administrator.
Logging in as the Administrator (P 122)
Web browser (Common to Windows/ Macintosh)

②② Click [Network].
⑧⑧ The values set in the printer are saved and the network function is
restarted.

8
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③③ Click on [Email]-[Send Settings].

⑤⑤ Set the address required to send to in [STEP2].
(1) Set the email server domain name or IP address [SMTP Server].
(2) S
 et the email address given to the printer in [Printer Email
Address].
(3) S
 et the email address used for sending emails from the
printer in [Reply-To-Address].
In normal situations, please set the printer administrator
email address.
Note!

Web browser (Common to Windows/ Macintosh)

④④ In [STEP1], set [SMTP Send] to [Enable].

• If [SMTP Server] is set to the domain name, the DNS server
must be set within [TCP/IP] settings.
•• Sending of mails from the printer must be permitted on
the mail server. For mail server settings, please consult the
network administrator.

⑥⑥ After this, if you want to configure more detailed settings, click

[Set detail of the SMTP Protocol] in [STEP3].
If you will not configure these settings, please proceedure to 18 .

8
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⑦⑦ Click [SMTP Security Settings].

⑯⑯ Set the reply email address for emails sent from the printer in

⑧⑧ Set [SMTP-Auth] to [Enable].

⑰⑰ Click on [OK].

⑩⑩ Enter [SMTP Server Password].

⑲⑲ The values set in the printer are saved and the network function

⑨⑨ Enter [SMTP Server UserID].

• If there is a mistake in [SMTP Server UserID] and [SMTP
Server Password] the mail sending function will not work
properly. Please pay attention to this.

⑪⑪ Click on [OK].

⑫⑫ Click on [Conﬁgure attached information].

⑱⑱ Click [Submit].
is restarted.

The method for authentication will be automatically selected from
authentication methods supported by the mail server.
Faults occuring will be regularly reported

①① Click on [Email] - [Alert Settings].

Web browser (Common to Windows/ Macintosh)

Note!

[Reply-To Address]. In normal situations, please set the printer
administrator email address.

8
⑬⑬ Select or enter the information you would like to add to the end
of messages sent by Email.

⑭⑭ Click on [OK].

⑮⑮ Click on [Others].
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②② Enter the destination email address for fault notifications.

⑤⑤ You can send the interval between sending of emails in [Setting
Email Alert Interval].

Web browser (Common to Windows/ Macintosh)

③③ Click the [Setting] button for the set email address.
Memo

• By clicking the [Copy] button you can copy the fault
notification conditions to another addressee. This is useful
when setting the same kind of fault notification settings for
multiple addressees.

④④ Put a check in [Periodically] and click on [To STEP2].

8
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Memo

• If no fault occured in the period for the target notification, no
email will be sent.

⑥⑥ Put a check in the fault type in [Setting Events Used for Sending
E-mall Alerts] for the notification target.

⑦⑦ Click on [OK].

⑧⑧ Check the details of the set fault notification conditions.
(1) If you want to display a list
		 a. C
 lick the [View a Summary of Current Conﬁguration]
button.

(2) If you want to compare two addressee setting conditions
		 a. Select each addressee you want to compare in the list box.
		 b. Check the set details displayed.
Click in the set conditions comparison table and change the
notification conditions.

		 b. Check the details of the settings and close the window.

Web browser (Common to Windows/ Macintosh)

⑨⑨ Click [Submit].

8
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⑩⑩ The values set in the printer are saved and the network function
is restarted.

Notify when faults occur

①① Click [Email] - [Alert Settings].

③③ Click the [Setting] button for the set email address.
 y clicking the [Copy] button you can copy the fault
B
notification conditions to another addressee. This is useful
when setting the same kind of fault notification settings for
multiple addressees.

④④ Put a check in [Upon occurrence of an event] and click on [To
STEP2].

Web browser (Common to Windows/ Macintosh)

⑤⑤ Put a check in the fault type in [Setting upon occurrence of an
②② Enter the fault notification destination email address.

8
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event] for the notification target.

⑥⑥ Set a delay from when an error occurs to when an email is sent.

(2) If you want to compare two addressee setting conditions
		 a. S
 elect each addressee you want to compare in the list
box.
		 b. Check the set details displayed.
You can change the notification conditions by clicking in the set
conditions comparison table.

Memo

Web browser (Common to Windows/ Macintosh)

• Depending on the delay time set, you can have only errors
continually occuring over a long time notified.
•• If you set the delay time to [0 Hours 0 Minutes], an email will
be sent as soon as an error occurs.

⑦⑦ Click on [OK].

⑧⑧ Check the details of the set fault notification conditions.

(1) If you want to display a list

8

		 a. C
 lick the [View a Summary of Current Conﬁguration]
button.
		 b. Check the details of the settings and close the window.
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⑨⑨ Click [Submit].

•• Using SNMPv3

The SNMPv3 agent is available.
You can encrypt printer management with SNMP and carry it out
safely by using an SNMP manager that supports SNMPv3.
Configuring SNMPv3

①① Log in as the administrator.
Logging in as the Administrator (P 122)

②② Click [Network].
Web browser (Common to Windows/ Macintosh)

⑩⑩ The values set in the printer are saved and the network
function is restarted.

③③ Click on [SNMP] - [Settings].

8
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④④ Put a check in the SNMP version you are using in [STEP1].
Click [To STEP2].

⑥⑥ Enter the passphrase for authentication use in [Passphrase]
within [Authentication Settings].

⑦⑦ Select [Algorithm].
• If you selected [SNMPv3] it will not be possible to refer to/ set
SNMPv1. If you selected [SNMPv3+v1], you can refer to both
SNMPv1 and SNMPv3, however, you can only configure setting
for SNMPv3.

⑤⑤ Enter the SNMPv3 username into [User Name] in [STEP2].
⑧⑧ Enter the passphrase for encryption use in [Passphrase] within
[Privacy (Encription) Settings].

Memo

Web browser (Common to Windows/ Macintosh)

Memo

8
• You can only select [DES] for the encryption algorythm.
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⑨⑨ Click [Submit].

•• Using IEEE802.1X

The authentication function using IEEE802.1X is supported.
Note!

• You may not be able to use this correctly depending on the
network environment you are using.

The IEEE802.1X setup process

⑩⑩ The values set in the printer are saved and the network
function is restarted.

At first, use a connection for setup through the hub normally used
by the printer and computer. Thereafter, connect ther printer to
the authenitication switch.

Web browser (Common to Windows/ Macintosh)

1. Connect the printer and the computer.
2. Set the IP address for setup use on the computer.

Memo

• Set context name of the SNMP manager you are using to
[v3context].

3. S
 et the IP address for setup use on the printer.
For the connection between the printer and computer and the
method of setting the printer IP address, please refer to the
Setup Instructions.
4. Set IEEE802.1X on the printer.
5. Connect the printer to the authentication switch (P 160).
The following explaination uses the environment shown below as
an example.

8

Printer

:B840dn

IP Address
		

:192.168.0.3 (The address used for computer setup)
:192.168.0.2 (the address used for printer setup)

Subnet mask : 255.255.255.0
Web browser :Microsoft Internet Explorer Ver.6.0
Configuration for IEEE802.1X

①① Log in as the administrator.
Logging in as the Administrator (P 122)
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②② Click [Network].

③③ Click the [IEEE802.1X] menu.

⑤⑤ Select [PEAP] for [EAP Type].

⑥⑥ Enter a user name in [EAP User].

⑦⑦ Enter a password in [EAP Password].

Web browser (Common to Windows/ Macintosh)

⑧⑧ Put a check in [Authenticate Server].

If Using PEAP

Memo

• If using EAP-TLS, please proceed to P 158.

④④ Select [Enable] for [IEEE802.1X].

8
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⑨⑨ Click [Import of CA Certiﬁcate].
Memo

• If [Not authenticate Server] is checked, it is not necessary to
import a CA certificate.
•• If [Not authenticate Server] is checked, you will not be
able to check whether there is a correct connection to the
authentication server.

⑪⑪ Click [Submit].

⑫⑫ The values set in the printer are saved and the network
function is restarted.

If [ONLINE] is displayed in the operating panel, turn the
printer power off.
Setup Instructions (Turning Off the Printer)

⑬⑬ Proceed to Connecting to the Printer Authentication Switch (P 160).
If Using EAP-TLS
Web browser (Common to Windows/ Macintosh)

④④ Select [Enable] for [IEEE802.1X].
The "Import of CA Certiﬁcate" screen will be displayed.

⑤⑤ Select [EAPTLS] for [EAP Type].

⑩⑩ Enter the file name of the CA certificate and then click [OK].
Memo

• The imported CA authentication certificate is an authentification
certificate of the RADIUS server server authentication
certificate issuing authority.
•• The file formats that can be imported are PEM, DER, and PKCS#7.

⑥⑥ Enter a user name in [EAP User].

⑦⑦ Put a check in [Not use SSl/TLS Cartiﬁcate for EAP
authentication].

8

Note!

The CA authentication certificate is imported to the printer.
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• Normally, please do not put a check in [Use SSL/TLS Certiﬁcate
for EAP authentication].

⑧⑧ Click [Import of Client Certiﬁcate].

⑫⑫ Click [Import of CA Certiﬁcate].
If [Not authenticate Server] is checked, it is not necessary to
import a CA certificate.
Memo

• If [Not authenticate Server] is checked, you will not be
able to check whether there is a correct connection to the
authentication server.

The "Import of Client Certiﬁcate" screen will be displayed.

Memo

• Authentication certificate files that can be imported are in the
PKCS#12 format.

⑩⑩ Enter the password of the client authentication certificate and
then click [OK].

The Import of CA Certiﬁcate screen will be displayed.

⑬⑬ Enter the file name of the CA certificate and then click [OK].
Memo

• The imported CA authentication certificate is an authentification
certificate of the RADIUS server server authentication
certificate issuing authority.
•• The file formats that can be imported are PEM, DER, and
PKCS#7.

Web browser (Common to Windows/ Macintosh)

⑨⑨ Enter the file name of the client authentication certificate.

8
The client authentication certificate is imported to the printer.

⑪⑪ Put a check in [Authenticate Server].
The CA authentication certificate is imported to the printer.
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⑭⑭ Click [Submit].

List of Setting Items
•• Status Tab

⑮⑮ The values set in the printer are saved and the network
Web browser (Common to Windows/ Macintosh)

8

function is restarted.

If [ONLINE] is displayed in the operating panel, turn the
printer power off.

Item
Printer Status

Setup Instructions (Turning Off the Printer)

Also, each network service operation status and
printer information list and IP addresses set on the
printer can be checked.

⑯⑯ Proceed to Connecting to the Printer Authentication Switch.
Connecting Your Printer to Authentication Switch

①① Make sure that the printer is turned off.

②② Plug the Ethernet cable into the printer network interface
connector.

③③ Plug the Ethernet cable into the authentication port of the
authentication switch.

④④ Turn the printer power ON ( | ).

⑤⑤ Check that [ONLINE] is displayed on the control panel.

⑥⑥ Set the printer IP address, etc., as per the environment you
are using. Set Item List
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Description
You can check the printer status. Other than the
same information as displayed on the operating
panel, all warnings and erros occuring on the
printer as Fault Information are displayed.

You can click on [Status Window] to check the
printer status in the web browser.
Printer Information

You can check printer system information.

Network
Information

You can check network setting information.

•• Printer Tab

(Printer Tab Continued)

This will be displayed if you are logged in as the printer administrator.

Item
Information Print

Description
Print network setting information (Network
Information), demo pages, etc.

•• Network Tab

This will be displayed if you are logged in as the printer
administrator.
Description

General printer
settings

You can set the information for printers that can be
checked on the network.

Print Menu

You can set the number of copies, automatic tray
switching, print quality, and print position. If using
a printer driver, the settings in the printer driver
will have priority over the settings configured here.

Media Menu

You can set the paper size for each tray and
custom paper, etc. If using a printer driver, the
settings in the printer driver will have priority over
the settings configured here.

Printer Conﬁg Menu You can configure settings for when moving into
powersave, operations at the time of the alarm
going off, during time-out, etc.

Item

Description

General Network
Settings

You can stop network protocols that you are not
using.

TCP/IP

You can set information related to TCP/IP.

NetWare

NYou can set information related to NetWare.

EtherTalk

You can set information related to EtherTalk.

NBT/NetBEUI

You can set information related to NetBEUI.

Email

You can configure settings for a function for email
notification of events occuring on the printer.

Emulation

You can set teh supported emulation.

Interface

You can set interfaces outside of the network.

Memory Menu

You can set the buffer size, etc., for received email.

SNMP

You can set information related to SNMP.

Time Setup

You can set the time on the printer.

IPP

System Setup

You can set the LED control method at the time
when the near-life warning occurs.

You can configure settings for the IPP print
function.

SNTP

You can set the time on the printer.

Save/Restore

You can save current menu settings, or change
saved menu settings.

IEEE802.1X

You can set information related to IEEE802.1X/EAP.

8

This targets the printer tab menu settings.
Hex Dump

Web browser (Common to Windows/ Macintosh)

Item

All received print data is displayed in hexadecimals.
This mode is exited when the printer is restarted.
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•• Job List Tab

•• Security Tab

This will be displayed if you are logged in as the printer
administrator.

Item
Web browser (Common to Windows/ Macintosh)

8

Settings

Description
Display a list of print jobs sent to the printer. If
there are unnecesary jobs, you can delete them.

•• Print Tab

Item

Description

Web Printing

You can set any PDF file you want and print it.

Email Printing

If a PDF file is attached to an email sent to the
printer, it can be printed.

162

Item

Description

Protocol ON/OFF

You can stop network protocols and network
services that you are not using.

Panel Lockout

Set the control panel so that operating it is
prohibited.

IP Filtering

You can restrict access with TCP/IP. Access
from outside the company is also supported.
However, sufficient knowledge regarding
IP addresses is required for this function.
Depending on the settings, serious problems
could occur, such as not being able to access
the printer from the network.

MAC Address
Filtering

You can restrict access based on MAC
addresses. Access from outside the company
is also supported. However, sufficient
knowledge regarding MAC addresses is
required for this function. Depending on the
settings, serious problems could occur, such
as not being able to access the printer from
the network.

•• Maintenance Tab

(Security Tab Continued)
Item

Description

You can encrypt configuration of settings
from the webpage as well as communication
between the computer (client) and printer at
the time of IPP printing.

IPSec

You can configure settings to encrypt
communication between the computer (client)
and printer and prevent tampering.

Change Admin
Password

You can change the administrator password.
The default password is "aaaaaa".

Change Network
Password

Change the [Network Setting] administrator
password for TELNET and Configuration
Tool.The default password is the last 6
alphanumerical digits of the MAC address.

This will be displayed if you are logged in as the printer administrator.

Item
Reset /
Restore

Reset Printer

Description

Restart the printer. As the network
function is also restarted at the same
time, the website will not be displayed
until restarting is complete, even if
you access from a web browser.

Reset
Restart the network function only.
Network Card If accessing the printer through

the network, this connection will
be broken. The website will not be
displayed until restarting is completed,
even if accessed from a web browser.

Restore
Printer to
Factory
Defaults

Initialize the printer. If you initialize
the printer, you will be able to operate
the printer, however, you will loose
manually-set information.

Restore
Initialize the network. If you initialize the
Network Card printer, you will be able to operate the
to Factory
printer, however, you will loose manuallyDefaults

set information. Also, as the IP address
will return to its initial condition, it may
not be possible to display the website.
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Web browser (Common to Windows/ Macintosh)

SSL/TLS

8
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(Maintenance Tab Continued)
Item

Description

Network Scale Setting

Settings used to further improve
efficiency of operations on the
network. If using a hub with a
spanning tree function, effects are
produced if one computer is connected
to one printer with a cross cable.

Time Settings

You can set the time on the printer.

Web browser (Common to Windows/ Macintosh)

•• Link Tab

Item

Description

Links

Links set by the manufacturer or by the administrator
are displayed.

Edit Links

The administrator can freely set the URL. 5 support
links and 5 other links can be set. Enter the URL so
that it includes http://.

8
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OKI LPR Utility

(only for Windows)

You can print, manage print jobs, and check the printer status
through a network connection.

④④ Read the [Software License Agreement], and click on [I Agree].
⑤⑤ Click on [Optional Software].

Operating environment
Computers running Windows 8.1/Windows 8/Windows 7/Windows
Vista/Windows XP/Windows Server 2012 R2/Windows Server 2012/
Windows Server 2008/Windows Server 2008 R2/Windows Server
2003
A computer operating with TCP/IP.
Note!

⑥⑥ Click on [LPR Utility].

The following explanation uses Windows 7 Ultimate Edition as an
example.
Install

①① Turn the printer power ON ( l ).

②② Check that the computer is launching and set the Software
DVD - ROM that comes with the printer in the drive.

The setup program will launch.

③③ Select the printer you are using, and click on [Next].

⑦⑦ If launching an OKI LPR Utility that has already been installed,
the completion screen will come up, so click on [Yes].

OKI LPR Utility (only for Windows)

• The OKI LPR Utility cannot be used for shared printers. To connect
with a network and then print, use a Standard TCP/IP port.
•• For setup, computer administrator rights are required.
•• The printing method function cannot be used.

8

⑧⑧ The setup program will start, so click on [Next].
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⑨⑨ Check the destination to install to and spool destination, and
click on [Next].

Main methods of use
• Launching the Utility

①① Select [Start] - [All Programs] - [Okidata] - [OKI LPR Utility] [OKI LPR Utility].
The following kind of screen will be displayed.

⑩⑩ Confirm that there is a check placed in [Register at Startup],
and click on [Next].

⑪⑪ Check the program folder name and click on [Next].
OKI LPR Utility (only for Windows)

• Add a Printer

You can change the printing destination port to the OKI LPR port.
Note!

⑫⑫ Click on [Finish].

8
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• You cannot set settings for already registered in OKI LPR Utility.
If you want to change the port, select [Set Printer Again].
•• You cannot add or delete printers if other users are also using
it by using the easy user switchover function.
•• Computer administrator rights are required.
•• If you wish to add a printer in Windows 7 /Windows Vista /
Windows Server 2008 /Windows Server 2008 R2, close the
OKI LPR Utility once, right click on [Start] - [All Programs] - [Oki
data] - [OKI LPR Utility] - [OKI LPR Utility], and select [Run as
administrator] in order to launch.

①① Select [Add Printer] from the [Remote Print] menu.

The status of the machine is displayed.

②② Enter the printer name in [Printer Name] and the printer IP ad-

Memo

dress in [IP Address], and click on [OK].

• You can also select [Status] in the job display dialog.

• Print Simultaneously with Multiple Printers

You can print from multiple printers with a single print command.
• It will only be displayed if the printer driver in [Printers and
Faxes] folder has been added in [Printer Name]. If a network
printer is set it will not be displayed.
•• You can search for Oki Data printers on the network by clicking
on [Discover].

• Check the Status of the Printer

Note!

• You must set printers from which you print simultaneously to
be the same printer model.
•• Computer administrator rights are required.

①① Select a printer.
②② Select [Confirm Connections] from the [Remote Print] menu.

①① Select a printer.
②② Select [Printer Status] from the [Remote Print] menu.

OKI LPR Utility (only for Windows)

Memo

8

③③ Click on [Details].
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④④ Put a check in [Print to more than one printer at a time] and
click on [Options].

⑥⑥ Repeat the operation in step ⑤ for the number of printers you
want to add.

Memo

• You can save added printer information by clicking on [Save
list].
•• You can import or delete saved printer information by clicking
on [Load list].

⑦⑦ Click on [OK].

• Automatically Transfer Printer Data

OKI LPR Utility (only for Windows)

⑤⑤ Click on [Add] to set the IP address of printers to print simultaneously from.

You can have print data automatically forwarded to other printers
when printing cannot be done due to a printer being in - use, offline,
or out of paper.
Note!

•Y
 ou cannot forward to printers made by other manufacturers.
You must forward to the printers with the same model name.
•• Computer administrator rights are required.

①① Select a printer.
②② Select [Confirm Connections] from the [Remote Print] menu.

8

Memo
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• You can also add comments to printers from which you print
simultaneously. (P 172)

③③ Click on [Details].

⑦⑦ Repeat the operation in step

date forwarding destinations.

to

for the number of candi-

④④ Put a check in [Automatic Job Redirect Used].

If you want to only forward if an error occurs, such as if the
printer is [Offline] or [Out of Paper], put a check in [Redirect
only at the time of an error].

⑤⑤ Click on [Add].

• To change the order of priority of forwarding destinations, select the printer for which you want to change the priority from
[IP addresses of printers to which job is automatically redirected], and click the vertical [ ] or [ ] button. (Click the [ ] to
raise the level of priority, and click the [ ] button to lower the
level of priority).

⑧⑧ Click on [OK].

8

⑥⑥ Set the IP address of the forwarding destination.

Memo

OKI LPR Utility (only for Windows)

Memo

• You can search for Oki Data printers on the network by clicking
on [Discover].
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• Manually Transfer Printer Data

②② Select [Download] from the [Remote Print] menu.

You can have print data manually forwarded to other printers registered on the OKI LPR Utility when printing cannot be done due to
a printer being in - use, offline, or out of paper.
Note!

• You cannot forward to printers made by other manufacturers.
•• Please forward to the printers with the same model name.

①① Select a printer.
②② Select [Job Status] from the [Remote Print] menu.

OKI LPR Utility (only for Windows)

③③ Select the print job you want to transfer and select the for-

③③ Select the file to download and click on [Open].

Start the file download.

warding destination printer in [Redirect] within the [Job] menu.
• Launch a web browser

You can launch a web browser, set the printer network and configure menu settings from the OKI LPR Utility.
The job will be sent to the destination printer.

8
• Download the file to the printer

You can download the file to the printer and print it.

①① Select a printer.
170

☞☞

Web browser (P 121)

①① Select a printer.
②② Select [Web Setting] from the [Remote Print] menu.

Memo

• If the web port number has been changed, change the OKI LPR
Utility port number settings using the following procedure.
① Select a printer.
 elect [Confirm Connections] from the [Remote Print]
②S
menu.

• Delete Print Data

①① Select a printer.
②② Select [Job Status] from the [Remote Print] menu.

③③ Select the print job you want to delete and select [Delete Job]
③ Click on [Details].

• Automatically Configuring the IP Address

If the IP address of a printer connected to the DHCP server changes when turning on the power to it, you can automatically search
for the changed IP address and reconfigure it.
Note!

• The search target is as per the OKI LPR Utility search range.
•• Computer administrator rights are required.

①① Select [Setup] from the [Option] menu.

⑤ Click on [OK].
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OKI LPR Utility (only for Windows)

④ Enter the web port number into [Port Numbers].

within the [Job] menu.

8
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②② Put a check in [Auto Reconnect].

③③ Enter a comment in [Comment] and then click on [OK].

④④ Select [Show comments] from the [Option] menu.

③③ Click on [OK].

OKI LPR Utility (only for Windows)

• Change printer settings (add comments.)

You can add a comment to a printer you have added to the OKI
LPR Utility.
This is useful for entering items such as the printer installation
location and the printer optional equipment.

①① Select a printer.
②② Select [Confirm Connections] from the [Remote Print] menu.

8
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Network Extension (only for Windows)
You can check setting items from the printer driver and easily set the
composition of printer options.

③③ Select the printer you are using, and click on [Next].

Operating environment
Computers running Windows 8.1/Windows 8/Windows 7/Windows
Vista/Windows XP/Windows Server 2012/Windows Server 2012
R2/Windows Server 2008/Windows Server 2008 R2/Windows
Server 2003
A computer operating with TCP/IP
Note!

④④ Read the [Software License Agreement], and click [I Agree].
⑤⑤ Click [Optional Software].

Install
Here Windows 7 Ultimate Edition is used as an example.

⑥⑥ Click [Network Extension].

8

①① Turn the printer power ON ( l ).
②② Check that Windows is launching and set the Software DVD ROM, that comes with the printer, in the drive.
The setup program will launch.

Memo

Network Extension (only for Windows)

• The printer driver must been installed in order to carry out
operations related to the printer driver.
•• If you install a printer driver with a TCP/IP network connection,
Network Extension will be automatically installed.
•• Connection to the printer driver is only carried out in the following situations.
OKI LPR Port
Standard TCP/IP Port
•• If the operating environment does not match, the [Option] tab
will not be displayed, even if Network Extension is installed.
•• For setup, computer administrator rights are required.

• If [Run Automatically] is displayed, click [Run setup.exe].
•• If [User Account Restrictions] is displayed, click [Yes] (in
Windows Vista/Windows Server 2008, this is [Continue] ).
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⑦⑦ Click [Next].
⑧⑧ Click [Finish].

④④ Click [Update].

Main methods of use
• Check Printer Settings

You can check the details of the connected printer settings.

①① For Windows 7/Windows Server 2008 R2, select [Start] - [Devices and Printers].

Network Extension (only for Windows)

For Windows Vista/Windows Server 2008, select [Start] - [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].

(The Windows PCL printer driver screen)

The details of the printer settings are displayed in [Device Settings].

⑤⑤ Click on [OK].

For Windows Server 2003, select [Start] - [Printers & Faxes].

②② With your mouse, right click on the printer driver for which you
want to check the settings, and select [Printer Properties] or
[Properties].

③③ Click the [Status] tab.

• Set Options Automatically
You can get the composition of options of the connected printer
and automatically configure the printer driver settings.

①① For Windows 7/Windows Server 2008 R2, select [Start] - [De-

8

vices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

174

②② With your mouse, right click on the printer driver icon for which

②② With your mouse, right click on the printer driver for which you

③③ Click the [Device Options] tab (for B840PS drivers, this is [De-

③③ Click the [Status] tab.
④④ Click on [Web Setting]. Launch a web browser.

you want to configure the settings, and select [Printer Properties] or [Properties].
vice Settings] ).

④④ Click on [Get Printer Settings]. (For B840 PS drivers, click on
[Get Printer Information] and then click on [Setup].)

want to check the settings, and select [Printer Properties] or
[Properties].

☞☞

Web browser (P 121)

Network Extension (only for Windows)

(The Windows PCL driver screen)

⑤⑤ Click on [OK].

(The Windows PCL driver screen)

• Launch a web browser

①① For Windows 7/Windows Server 2008 R2, select [Start] - [De-

8

vices and Printers].

For Windows Vista/Windows Server 2008, select [Start] - [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].
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Network Card Setup

(only for Windows)

You can configure printer network settings or display the web browser.

⑤⑤ Click on [Device Configuration] and click on [Network Card Setup].
Launch Network card setup.

Operating environment
Windows 8.1/Windows 8/Windows Server 2012/Windows Server
2012 R2/Windows 7/Windows Vista/Windows Server 2008/Windows Server 2008 R2/Windows XP/Windows Server 2003
A computer operating with TCP/IP
Memo
Note!

Network Card Setup (only for Windows)

8

• For Windows 7/Windows Vista/Windows Server 2008/Windows
Server 2008 R2/Windows XP/Windows Server 2003
administrator rights are required for setup.

Here Windows XP Home Edition is used as an example.
Main methods of use
• Launching the Utility

①① Turn the printer power ON ( l ).
②② Check that Windows is launching and set the Software DVD ROM in the drive.

The setup program will launch.

③③ Select the printer you are using, and click on [Next].
④④ Read the [Software License Agreement], and click [I Agree].
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• If at the time of launching the NIC Setting Tool on Windows 7/
Windows Vista/Windows Server 2008/Windows Server 2008
R2/Windows XP/Windows Server 2003 there is a message displayed saying [Windows Security Alert], click [Allow access].

• Configure printer network settings

①① NIC Settings Tool will launch.
②② Refer to the IP address or the MAC address from the list, and
select the printer you would like to configure.

Memo

• The MAC address will be displayed in Network Information.
(Setup Instructions)
•• For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be displayed.

③③ Select [Setting Printer] from the [Setting] menu.

④④ Enter the required items and click on [OK].

⑦⑦ When restarting the printer has finished, the set printer status
will turn

(Green).

⑧⑧ Close Network card setup.

• Display the website

⑤⑤ Enter the password in [Admin Password Required] and then

①① Launch Network card setup.
Launching (P 176)

②② Refer to the IP address or the MAC address from the list, and
select the printer you would like to configure.

Note!

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
•• When entering the password, [******] will be displayed on
the screen.
•• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

⑥⑥ If [Setup Completed] is displayed, click [OK]. Printer restarting
will commence.

Note!

• The MAC address will be displayed in Network Information.
(Setup Instructions)
•• For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be displayed.

③③ Select [Setting Printer] from the [Setting] menu.
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Network Card Setup (only for Windows)

☞☞

click [OK].

8
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④④ Select [Printer Web Page - Enable] in the [Printer Web Page]
tab, and click on [OK].

⑦⑦ When restarting the printer has finished, the set printer status
will turn

(Green).

⑧⑧ Select [View Web Page] from the [Setting] menu.

Network Card Setup (only for Windows)

8

⑤⑤ Enter the password in [Admin Password Required] and then
click [OK].

The website will be displayed.

• Change the network password

①① Launch Network card setup.
Memo

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
•• When entering the password, [******] will be displayed on
the screen.
•• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

☞☞

Launching (P 176)

②② Refer to the IP address or the MAC address from the list, and
select the printer you would like to configure.

⑥⑥ If [Setup Completed] is displayed, click [OK]. Printer restarting
will commence.

Memo
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• If the webpage is displayed, the MAC address is displayed in
[Printer Information]. (P 195)
•• For initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be displayed.

③③ Select [Change Password] from the [Setting] menu.

• Setting the Environment

①① Launch Network card setup.

☞☞

Launching (P 176)

②② Select [Environment Settings] from the [Option] menu.
④④ Enter the current password and new password and click [OK].

[Printer Discovery] tab
You can set the search conditions for the printer you are looking
for.
You can search for printers on the same segment by enabling
[Search Local Subnets].

• On the first time the password is the last 6 digits of the referenced MAC Address. In this example, it is 62F8D8.
•• When entering the password, [******] will be displayed on
the screen.
•• When entering the password, please make sure that you enter
upper and lower - case letters correctly.

⑤⑤ If the [Setting Complete] screen is displayed, click [OK].

Network Card Setup (only for Windows)

Memo

If searching for individual printers you can add the IP address of
the printer you are searching for.

8

179

Chapter 8 Regarding Networks

[Time Out] Tab
You can set the amount of time until timeout.

Network Card Setup (only for Windows)

[Display Item] tab
You can set the items displayed in a list.

8

180

Network Card Setup

(only for Macintosh)

You can configure network settings or view the web browser.
Operating environment

• Configure the IP Address
Memo

Mac OS X 10.6.8 - 10.9

Main methods of use
• Launching the Utility

①① Launch Network Card Setup.
②② Select [IP Address Settings] from the [Operations] menu.
③③ Enter the required items and click on [Save].

Setup] folder.

• Search for a Printer

①① Launch Network Card Setup.
②② Select [Search Devices] from the [Operations] menu.
The printer information is displayed in a list.

Memo

• If you want to change the search conditions, please refer to Set
Printer Search Conditions. (P 183)

④④ Enter the password in [Password] and then click [OK].
Memo

• I n the default settings, the password is the last 6 digits of the
MAC address.
•• The MAC address will be displayed in Network Information.
(Setup Instructions)
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Network Card Setup (only for Macintosh)

①① Set the Software DVD - ROM in the computer.
②② Click on [Network Card Setup] in [Utility] - [Network Card

•F
 or initial configuration, the method of obtaining IP addresses
is [DHCP/BOOTP]. If there is a DHCP/BOOTP server on the
network, the IP address obtained from the network will be displayed.

8
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⑤⑤ If [Settings updated successfully.] is displayed, click [OK].①
Restart the printer.

⑥⑥ If the printer starts up, select the printer which you want to

change the settings for from the printers displayed in Network
Card Setup, and select [Show Device Webpage] in the [Operations] menu. The printer website will be displayed.

• Display the website

①① Launch Network Card Setup.

☞☞

Launching (P 181)

②② Select [Web Settings] from the [Operations] menu.
③③ Check [Device web settings will be enabled] and click on [Save].

Network Card Setup (only for Macintosh)

8

• Changing the Password
You can change the password used to configure the printer settings.
Memo

• In the default settings, the password is the last 6 digits of the
MAC address.
•• If the webpage is displayed, the MAC address is displayed in
[Printer Information]. (P 177)

①① Launch Network Card Setup.
④④ Enter the password in [Password] and then click [OK].
Memo

• In the default settings, the password is the last 6 digits of the
MAC address.
•• The MAC address will be displayed in Network Information.
(Setup Instructions)

☞☞

Launching (P 181)

②② Select the printer you want to change the settings for and select [Change Password] on the [Operations] menu.

③③ Enter the current password.
④④ Enter a new password.
⑤⑤ For confirmation purposes, reenter the new password.
⑥⑥ Click [Save].

⑤⑤ If [Settings updated successfully.] is displayed, click [OK]. The
printer will launch.

⑦⑦ If [Settings updated successfully.] is displayed, click [OK]. The
printer will restart.
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• Set the search conditions for the printer you are looking for
The settings will be saved until the next time you launch Network
Card Setup.
If searching for individual printers you can add the IP address of
the printer you are searching for.

①① Launch Network Card Setup.

☞☞

Launching (P 181)

• Set timeout conditions
You can set the reboot monitor timeout.

①① Launch Network Card Setup.

☞☞

Launching (P 181)

②② Select [Preferences...] from the [Network Card Setup] menu.
③③ Enter required items.

②② Select [Preferences...] from the [Network Card Setup] menu.
③③ Click [+] and enter IP address you want to register.
④④ If you want to delete the registered IP address, select the ad-

Network Card Setup (only for Macintosh)

dress you want to delete from the list and click [-].

⑤⑤ If you want to search for a printer in the same segment, put a
check in [Search Local Subnets].

8
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TELNET (Common to Windows/ Mac OS X)
You can set each network protocol for the printer.
Main methods of use
The following explanation uses the environment shown below as an
example.
Windows
: Windows XP Professional
Printer
: B840dn
IP Address
: 192.168.0.2
MAC Address : 00:80:87:84:9C:9B
Memo
TELNET (Common to Windows/Mac OS X)

8

• If you launch the web browser, the MAC address will be displayed in [Printer Information]. (P 121)

④④ Enter a login name and password.
Memo

• The login name is [root] and the initial password value is the
[Last 6 Digits of the MAC Address].

B840dn TELNET Server (Ver 01.00).
login: root
'root' user needs password to login.
password:
User 'root' logged in.
• Configure each type of settings

①① Launch TELNET.
• Launching the Utility

① If you are using Windows

Start the command prompt.

If you are using Mac OS X
		 Start the terminal.

②② Check the connection using a ping command.
		 ping 192.168.0.2

③③ Connect to the printer using telnet.
		 telnet 192.168.0.2

No. MENU (level.1)
- - - - - - - - - - - - - - - - - - - - - 1 : Status / Information
2 : Printer Config
3 : Network Config
4 : Security Config
5 : Maintenance
99 : Exit Setup
Please select (1 - 99) ?

②② Enter the number for the item to change and press the Enter
key.

③③ Set each item.
④④ Log out from the printer.
The values set in the printer are saved and the network
function is restarted.
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Cannot print from Windows
Note!

• For questions related to applications, please enquire at each application vendor.

• Initial checks

• If the compatibility of the hub is the reason

 ommunication may be unstable due to compatibility of the hub.
C
Set the printer's [HUB LINK SETTING] to [10BASE - T HALF].
Please refer to the below for the method of configuring settings.

Occurrence

•• C
 heck the LINK 100M lamp (Green) /LINK 10M lamp (Green).
If connected to 100BASE - TX/10BASE - T, either will be lit. If
it is not lit, the network is not functioning correctly.
•• C
 heck the STATUS lamp (Orange). This flashes when data is
being received. If it is flashing at regularly intervals (1 or 0.1
seconds), always flashing, or always off, the network is not
functioning correctly.
•• The hub LINK lamp is not flashing.
•• There is no response to a ping.
•• Printing was not complete, and printing was cancelled.
• If the network connection is the cause
Cannot print from Windows

•• Check that the printer power is ON ( l ).
•• Check that the cable is properly connected to the printer.
•• C
 heck that it is connected with the correct cable. There are
two types of cable, straight cable and cross cable. Straight
cables are used to connect to hubs.
•• T
 urn the printer power ON ( l ), after connecting the cable.
If you turn the printer power ON ( l ) before connecting the
cable, you may not be able to connect to the network.

9

①① Press the

or the

button several times, and the

[NETWORK MENU] will be displayed.

②② Press the
③③ Press the

ENTER button.
or the

button, and [HUB LINK SETTING/

AUTO NEGOTIATE] will be displayed.

④④ Press the
⑤⑤ Press the

ENTER button.
or the

button several times, and the

[10BASE - T HALF] will be displayed.

⑥⑥ Press the

ENTER button, and a [*] will appear on the

right side of the value.

⑦⑦ Press the

Online button, and [ONLINE] will be displayed.

Change the hub operation mode (100BASE - TX/10BASE - T, Full
double redundancy/ Half redundancy) from Automatic Toggle to
10BASE - T HALF. (Please refer to the hub manual for the method
of configuring settings.)
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•• Click on [Properties] in [Internet Protocol (TCP/IP)], and check
that the [IP address], [Subnet Mask], and [Default Gateway]
are correct.

•• If this has still not solved the problem

Windows Vista
•• Select [Start] - [Control Panel] - [Display Network Status and
Tasks] - [Network Connection Management]. Click the [Local
Area Connection] tab, and click on [Properties] on the [Local
Area Connection] screen. If the [User Account Controls] screen
is displayed, click [Continue]. Check that [Internet Protocol Version 4 (TCP/IPv4)] is displayed.
•• Click on [Properties] in [Internet Protocol Version 4 (TCP/IPv4)]
and check that the [IP Address], [Subnet Mask, and [Default
Gateway] are correct.
•• If you set the printer by IP address at the time of setting up,
make the first part of each octect not [0]. E.g. set it such as
[192.169.1.2]. You cannot print correctly with it set to something like [192.169.001.002]. This is based on the Windows
Vista specifications.
•• Right click on the icon of the printer you are using in the [Printers] folder, select [Properties], click on [Port Build] in the [Ports]
tab, and check that [Printer Name or IP Address] matches the
printer's IP address.
•• For small networks, configure the following settings.
Windows

192.168.0.3

Printer

192.168.0.2

Windows

255.255.255.0

Printer

255.255.255.0

[Gateway]

Windows

Do not use

		

Printer

0.0.0.0

		
[Subnet Mask]
		

•• Right - click on the icon of the printer you are using within the
[Printers & Faxes] folder, click on [Port Build] within the [Port]
tab, and check that [Printer Name or IP Address] matches the
printer's IP address.
•• On the main screen of OKI LPR Utility, select the printer you
are using, select [Remote Print] - [Confirm Connections], and
check that the [IP Address] matches the printer IP address.
•• You can get the latest OKI LPR Utility from the Okidata website
(http://www.okiprintingsolutions.com/). When updating the
OKI LPR Utility, you can delete the old version and then install
the latest one.
•• Check the printer status in the OKI LPR Utility. If it goes into
[Pause], select the printer that has been stopped, and remove
the check from [Remote Print] - [Pause].
•• For small networks, configure the following settings.
[IP Address]

Windows

192.168.0.3

		

Printer

192.168.0.2

[Subnet Mask]

Windows

255.255.255.0

Printer

255.255.255.0

[Gateway]

Windows

Do not use

		

Printer

0.0.0.0

		

Cannot print from Windows

[IP Address]

•• If you set the printer by IP address at the time of setting up,
make the first part of each octect not [0]. E.g. set it such as
[192.169.1.2]. You cannot print correctly with it set to something like [192.169.001.002]. This is based on Windows XP/
Windows Server 2003 specifications.

Windows XP/Windows Server 2003

9

•• Select [Start] - [Control Panel] - [Networks & Internet Connections] - [Network Connections]. (For Windows Server 2003,
select [Start] - [Control Panel] - [Network Connections].
Double - click on [Local Connection], and check that [Internet
Protocol (TCP/IP)] is displayed in [Properties].
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●● Dealing with cases with other causes

Cannot Print.

Cannot print from Windows

9

The printer power is OFF
( O ).

Turn the printer power ON ( l ).

The interface is disabled.

Change the [PARALLEL] or [USB] in
the printer's menu settings to [ENABLE].

There is insufficient memory.
Lauch multiple applications simultaneously.

Close applications you are not using.

Printing is slow.

The printer cable has
come out.

Plug the printer cable in.

Print processing is carried out on the print
processing side.

It goes [OFFLINE].

Press the Online button to make it
go [ONLINE].

Set the printer driver's [Print Quality] to [Normal] or [Fast].

There is a problem with
the printer cable.

If you have a spare cable, replace
the other one with it.

Select [High Definition]
in [Print Quality] or
[Resolution].

Make the print data more simple.

Using a switch, buffer,
extension cable and
USB hub.

Connect the printer directly to the
computer.

The print data is complicated.

The printer driver output port is incorrect.

Set the output port to the one to
which the printer cable is connected
to.

Dealing with printing
from other interfaces.

Please wait until print processing is
complete.

The printer driver does
not show [Commonly Used Printers].

Make it into a [Commonly - Used
Printer].

Another bidirectional
parallel or USB operated printer driver is
installed.

Delete the other printer drivers.

The I - PRIME settings
do not match the computer.

Make the [I - PRIME] in the printer
menu into [3 MICRO SEC] or [50
MICRO SEC].

188

Use a computer with a fast processing speed.

Set up with a network connection. Cannot Print.
There is a problem with
the setup or method of
printing.

Refer to Cannot Print Through the
Network (P 191).

Cannot print from Macintosh
Note!

• For questions related to applications, please enquire at each application vendor.

• Initial checks

Occurrence
•• Check the LINK 100M lamp (Green) /LINK 10M lamp (Green).
•• If connected to 100BASE - TX/10BASE - T, either will be lit. If it
is not lit, the network is not functioning correctly.
•• Check the STATUS lamp (Orange). This flashes when data is
being received. If it is flashing at regularly intervals (1 or 0.1
seconds), always flashing, or always off, the network is not
functioning correctly.
•• The hub LINK lamp is not flashing.
•• There is no response to a ping.
•• Printing was not complete, and printing was cancelled.
• If the network connection is the cause

•• Check that the cable is properly connected to the printer.
•• Check that it is connected with the correct cable. There are two
types of cable, straight cable and cross cable. Straight cables
are used to connect to hubs.
•• Turn the printer power ON ( l ), after connecting the cable. If
you turn the printer power ON ( l ) before connecting the cable,
you may not be able to connect to the network.

Communication may be unstable due to compatibility of the hub.
Set the printer's [HUB LINK SETTING] to [10BASE - T HALF].
Please refer to the below for the method of configuring settings.

①① Press the

or the

button several times, and the

[NETWORK MENU] will be displayed.

②② Press the
③③ Press the

ENTER button.
or the

button, and [HUB LINK SETTING/

AUTO NEGOTIATE] will be displayed.

④④ Press the
⑤⑤ Press the

ENTER button.
or the

button several times, and the

[10BASE - T HALF] will be displayed.

⑥⑥ Press the

ENTER button, and a [*] will appear on the

right side of the value.

⑦⑦ Press the

Online button, and [ONLINE] will be displayed.

Change the hub operating mode (100BASE - TX/10BASE - T, full
redundancy/half redundancy) to 10BASE - T HALF. (Please refer to
the hub manual for the method of configuring settings.)
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Cannot print from Macintosh

•• Check that the printer power is ON ( l ).

•• If the compatibility of the hub is the reason

9
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●● If this has still not solved the problem

•• Confirm that their is a check in [Internal Ethernet] within [Apple Menu] - [System Preferences] - [Internet and Networks] [Network] - [Display] - [Network Port Settings].

●● Dealing with cases with other causes.

Printing is slow.
Print processing is carried out on the print
processing side.

Use a computer with a fast processing speed.

Select [High Resolution] for [Printer Quality].

Set the printer driver's [Print Quality] or [Resolution] to [Normal] or
[Fast].

The print data is complicated.

Make the print data more simple.

EPS files cannot be printed neatly.
EPS type files are printed with screen resolution 72dpi, because
they cannot be recogn i ze d b y Q u i c k D raw
(the MacOS drawing
system).

Change the file to a PICT, TIFF, or
other graphic format. Use a PS printer driver for B840dn.

Cannot print from Macintosh

The network connection cannot be set up. Cannot Print.
There is a problem with
the setup or method of
printing.

9
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Refer to Cannot Print Through the
Network (P 191).

Cannot print through the network
●●Utilities
•• Check that printer detection can be done in Configuration Tool
or in Network Card Setup (Windows).
•• Check that the printer can be detected in Network Card Setup
(Macintosh).
•• Check that you can connect to the printer with the web browser. (P 121).
•• Check that you can connect to the printer with telnet.
•• Check that you can connect to the printer with a ping. Enter
[ping xxx.xxx.xxx.xxx] (xxx.xxx.xxx.xxx is the printer's IP address) on the Windows command prompt (MS - DOS prompt)
and press the Enter key.

●●UNIX
•• Check that the printer's [IP Address] and [Host Name] is registered in "/etc/hosts file".
•• If using an lp protocol, check that the remote printer's logical
printer name (e.g.: rp=lp) is registered in "/etc/printcap file".
With B840dn, logical printer names are "lp", "sjis", and "euc",
and "lp" is used for non - convertible output settings, "sjis"
is used for shift JIS PostScript Japanese character conversion
output, and "euc" is used for EUC PostScript Japanese character conversion output. All others are disabled. With B820n, the
only enabled logical printer name is "lp".

Cannot print through the network

•• If using an ftp protocol, check whether an output destination (an
internet port logical device name) is set. With B840dn, output
destinations are "lp", "sjis", and "euc", and "lp" is used for non
- convertible output settings, "sjis" is used for shift JIS PostScript Japanese character conversion output, and "euc" is used
for EUC PostScript Japanese character conversion output. All
others are disabled. With B820n, the only enabled output destination is "lp".

9

191

Chapter 9 Troubleshooting

Deleting a Printer Driver
If you are using Windows 8/8.1/Windows Server 2012/Server
2012 R2/Windows 7/Windows Server 2008 R2
Note!

⑤⑤ Select the [Drivers] tab in [Print Server Properties].
⑥⑥ Click [Change Driver Settings].

• Computer administrator rights are required.
•• If Windows is launching, restart it.

①① Select [Start] - [Devices and Printers].

②② Select the printer name you want to delete, right click and select [Delete device].

③③ Select any printer icon from the [Devices and Printers] folder.

⑦⑦ Select the printer name you want to delete, and click [Remove].

Deleting a Printer Driver

④④ Click on [Print Server Properties] from the menu.

9
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⑧⑧ If Remove Driver And Package is displayed, select [Remove

②② Right - click on the icon of the printer you want to delete, and

⑨⑨ If [Print Server Properties] appears, click [Yes].

③③ If a confirmation message is displayed, click [Yes].

driver and driver package] and click [OK].

Note!

• I f a message appears saying [The specified printer driver
is currently in use.], restart Windows and carry out deletion of the printer driver again.

select [Delete].

④④ Without the printer icon selected, right - click on it, and select
[Run as administrator] - [Server Properties].

⑩⑩ If deletion is complete, click [OK].

⑪⑪ If you return to [Print Server Properties], click [Close].
⑫⑫ Restart Windows.

Note!

• Computer administrator rights are required.
•• If Windows is launching, please restart it.

Deleting a Printer Driver

If you are using Windows Vista/Windows Server 2008

⑤⑤ If [User Account Control] is displayed, click [Continue].
⑥⑥ Select the [Drivers] tab in [Print Server Properties].

①① Select [Start] - [Control Panel], and click on [Printers].

9

193

Chapter 9 Troubleshooting

⑦⑦ Select the printer name you want to delete, and click [Remove].

If you are using Windows XP/Windows Server 2003
Note!

• Computer administrator rights are required.
•• If Windows is launching, please restart it.

①① For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].

In Windows Server 2003, select [Start] - [Printers & Faxes].

②② Right - click on the icon of the printer you want to delete, and
select [Remove device].

Note!

• If a message appears saying [The specified printer
driver is currently in use.], restart Windows and carry
out deletion of the printer driver again.

⑧⑧ If [Remove Driver And Package] is displayed, click [Remove
driver and driver package.] and click [OK].

③③ Thereafter, follow the instructions on the screen.
Deleting a Printer Driver

9

④④ Select [File] - [Server Properties] in the [Printers and Faxes]
folder.

⑨⑨ If a confirmation message is displayed, click [Yes].

⑩⑩ If [Remove driver and driver package.] is displayed, click on
[Delete].

⑪⑪ If deletion is complete, click [OK].

⑫⑫ If you return to [Print Server Properties], click [Close].
⑬⑬ Restart Windows.
194

⑤⑤ In the [Drivers] tab, select the appropriate model name and
click on [Remove].

For those using a Mac OS X

1

Delete the printer name from a printer list.

①① Select [Apple Menu] - [System Preferences].
②② Click [Print & Scan].

③③ Select the printer name and click [ - ].

Note!

④④ Click [Delete Printer] on the confirmation screen.

• The Network Extension installed together with the printer driver is not deleted even if you delete the driver.
• For deleting Network Extension, please refer to Deleting
Utilities (P 112).

Delete with the installer (uninstall).

Deleting a Printer Driver

2

①① Set the Software DVD - ROM in the drive.

②② Open the [Driver] folder of the printer driver you want to
delete.

9
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③③ Double - click the [Uninstaller] tab.

④④ Check the model name on the uninstaller confirmation screen,
and click [OK].

⑤⑤ Enter the administrator's name and password and click [OK].
Deleting a Printer Driver

⑥⑥ If uninstalling is complete, click [OK].

9
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Updating a Printer Driver
If you are using Windows 8/8.1/Windows Server 2012/Server
2012 R2/Windows 7/Windows Server 2008 R2
Note!

F
 or PCL drivers, right - click the icon of the printer to update, and
select [Printer Properties]. Click on [About] in the [Device Options] tab.

• You must have administrator rights.
•• If Windows is launching, please restart it.

①① Click [Start] - [Devices and Printers].

②② Right - click the icon of the printer to update, and select [Printing Preferences]. Click on [About] in the [Job Options] tab.

(The Windows PCL printer driver screen)

③③ If the version information screen is displayed before the version, click [OK].

Updating a Printer Driver

(The Windows PS printer driver screen)

④④ Follow "If you are using Windows 7/Windows Server 2008 R2"
(P 192), within "Delete a Printer Driver", to delete a printer
driver.

197
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⑤⑤ Set up a new printer driver.
For the method of setting up, refer to the Users' Manual Setup

For PCL drivers, right - click the [Printer to Update] icon and select
[Properties]. Click on [About] in the [Device Options] tab.

Version.

Note!

• You must check that the printer power is ON ( l ).

⑥⑥ Display the version information screen using procedures

and check that the printer driver version has been updated.

,

If you are using Windows Vista/Windows Server 2008
Note!

• Computer administrator rights are required.
•• If Windows is launching, please restart it.

①① Select [Start] - [Control Panel], and click on [Printers].

②② For PS drivers, right - click the [Printer to Update] icon, and select [Printing Preferences].

(The Windows PCL printer driver screen)

③③ If the version information screen is displayed, before the version click [OK].

Click on [About] in the [Job Options] tab.
Deleting a Printer Driver

④④ Follow "If you are using Windows Vista/Windows Server 2008" ①

9

(P 193), within "Delete a Printer Driver", to delete a printer driver.

(The Windows PS printer driver screen)
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⑤⑤ Set up a new printer driver.

For PCL drivers, right - click the [OKI B840 (PCL)] icon and select [Properties]. Click on [About] in the [Device Options] tab.

For the method of setting up, refer to the Users' Manual Setup
Version.
Note!

• You must check that the power is ON ( l ).

⑥⑥ Display the version information screen using procedures

and check that the printer driver version has been updated.

,

If you are using Windows XP/Windows Server 2003
Note!

• Computer administrator rights are required.
• If Windows is launching, please restart it.

①① For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].

In Windows Server 2003, select [Start] - [Printers & Faxes].

②② For PS drivers, right - click the [Printer to Update] icon, and select [Printing Preferences].

(The Windows PCL printer driver screen)

③③ If the version information screen is displayed, click [OK] before
the version.

Click on [About] in the [Job Options] tab.
Updating a Printer Driver

9
(The Windows PS printer driver screen)
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④④ Right - click on the icon of the printer you want to update, and
select [Remove device].

	In order to correctly update the printer driver, delete all printer
drivers of the same type as the one you are updating.

⑧⑧ Restart Windows.

⑨⑨ Set up a new printer driver.
For the method of setting up, refer to the Users' Manual Setup
Version.
Note!

• You must check that the printer power is ON ( l ).
•• For Windows XP/Windows Server 2003, set up when installing the printer.

⑩⑩ Display the version information using procedures

- , and
check that the new printer driver version has been updated.

For those using a Mac OS X

⑤⑤ Thereafter, follow the instructions on the screen.

⑥⑥ Select [File] - [Server Properties] in the [Printers and Faxes]
folder.

⑦⑦ In the [Drivers] tab, select the appropriate model name and
click on [Remove].

Updating a Printer Driver

9
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①① Delete the printer driver.
For details, please refer to Delete a Printer Driver (P 195).

②② Reinstall the printer software. For details, refer to the Users'
Manual Setup Version.

If you cannot set up the printer driver
If you cannot setup with a USB connection (Windows)
●● If a printer icon is not created in the [Printers] folder
The printer driver cannot be correctly set up. Carry out the printer
setup again.
For details, refer to the Users' Manual Setup Version.
●● If a printer icon is created in the [Printers] folder, but you cannot print
The printer driver print destination port is not correctly set up.
Check the settings using the following procedure.

①① For Windows 8.1/Windows Server 2012 R2, select [Control
Panel] - [Hardware and Sound] - [Devices and Printers].

For Windows 8/Windows Server 2012, select [Control Panel] [Hardware and Sound] - [Devices and Printers].

●● If
 [An error occurred with installing the printer driver] in the setup program
you need to set up with plug and play. Check whether setup was
carried out using the following procedure.

①① Check that the printer and computer power is turned OFF ( O ).
②② Connect the USB cable.

③③ Turn the printer power ON ( l ).
④④ Launch Windows.

⑤⑤ If the [Add New Hardware Window] is displayed, after this follow the instructions on the screen to set up.

For details, please refer to README.TXT on the Software DVD ROM.
If you cannot set up the printer driver

For Windows 7/Windows Server 2008 R2, select [Start] - [Devices and Printers].
 or Windows Vista/Windows Server 2008, select [Start] F
[Control Panel], and then click on [Printers].
	For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers and Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

②② In Windows 7, select [Printer Properties].
I f not using Windows 7, right - click on the printer icon and
select [Properties].

9

③③ Set [Printer Port] in the [Ports] tab to [ [USBxxx].
Note!

• If [USBxxx] is not displayed in [Printer Port], check that
the printer power is ON ( l ), fix the USB cable connection, and carry out steps
again.
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●● For other cases
Occurrence

If you cannot setup with a USB connection (Macintosh)
Method of dealing with it

The computer does not Check that the USB controller is disrespond to the USB in- played using the device manager.
terface.

Occurrence

The interface is disabled. Set [USB] in the printer user menu to
[ENABLE]. For the detailed procedure,
refer to "User Menu" in "Chapter 2 -

The USB cable may not Please use a USB2.0 specification USB
meet the standards.
cable.

Basic Operation" in the Setup Instructions.

The interface is disabled. Set [USB] in the printer user menu to
[Enable]. For the detailed procedure, refer to "User Menu" in "Chapter 2 - Basic
Operation" in the Setup Instructions.
The set up procedure Follow the procedure in the Setup Inwas incorrect.
structions and set up again from the
beginning.
If you cannot set up the printer driver

The USB cable has come Plug the USB cable in.
out.
There is a problem with If you have a spare USB cable, replace
the USB cable.
the other one with it.
Using a USB hub.

Connect the printer directly to the
computer.

[Set Location to Search] Set it to the printer driver folder in the
or [Set Location] is disSoftware DVD - ROM.
played during setup.
E.g.: "E:\Drivers\ENU\PCL"
(In this example the DVD - ROM
drive is E:, and the printer driver

9

is PCL.)
Setup was aborted.
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Follow the procedure in the Setup Instructions and set up again from the
beginning.

Method of dealing with it

The USB cable may not Please use a USB2.0 specification USB
meet the standards.
cable.
The set up procedure was Set up again from the beginning.
incorrect.
The USB cable is pulled Increase the interval between pulling
out after a short time.
out the USB cable to over 5 minutes.
The USB cable has come Plug the USB cable in.
out.
There is a problem with If you have a spare USB cable, replace
the USB cable.
the other one with it.
Using a USB hub.

Connect the printer directly to the
computer.

Setup was aborted.

Set up again from the beginning.

The printer power switch Turn the printer power ON ( l ).
is OFF ( O ).
The printer driver cannot Install the printer driver again.
be correctly installed.
It goes [OFFLINE].

Press the Online button to make it go
[ONLINE].
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 Network interface specifications

USB interface specifications

Basic specifications

Basic specifications

Specifications

Network protocol

USB (Supports Hi - Speed USB)

TCP/IP - related

Connectors
Printer side

NetWare - related
EtherTalk - related
NetBEUI - related
Connectors
1
 00 BASE - TX / 10 BASE - T (Automatic toggle, cannot be used
simultaneously)

B receptacle (female) upstream port

Cable side		
B plug (Male)
Cable
A
 5m or lower USB2.0 specification cable (2m or lower is recommended)
(Please use a shielded cable.)

Cable
 on - shield twisted pair cable with RJ - 45 connector (Category 5 recommendN
ed)

Transmission mode
Full speed (Maximum 12 Mbps ±0.25%)

Connector pin arrangement

Power control
Self - powered device

1

8

High speed (Maximum 480Mbps ±0.05%)

Connector pin arrangement

		

2

1

3

4

				
Interface signal
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Pin
No.

Signal
name

Direction

1
2
3
4
5
6
7
8

TXD+
TXD RXD+
−
−
RXD −
−

FROM PRINTER
FROM PRINTER
TO PRINTER
−
−
TO PRINTER
−
−

Function
Data being sent+
Data being sent Data being received+
Not being used.
Not being used.
Data being received Not being used.
Not being used.

Interface signal
Signal
name

Function

1

Vbus

2

D-

Power (+5V)
For data transfer

3

D+

For data transfer

4

GND

Shell

Shield

Signal grand

ACC interface specifications

Note!

USB (only Oki Data checked card reader/writers)

Basic specifications
IEEEstd1284 - 1994 standard parallel interface
Connectors
Printer side
Cable side		

Specifications

Connectors
A receptacle (female) downstream port
Cable
Use the cable that belongs to the card reader.
(You cannot use the hub.)
Transmission mode
Low speed (Maximum 1.5 Mbps ±1.5%)
Supplied current
Maximum 500mA
Connector pin arrangement

• The parallel interface is disabled by default. If using the printer
interface, Set [Centro] on the printer control panel to [Enabled].
 Enabling a Parallel Interface (P 92)

36 - pole receptacle (female)
36 - pole plug (male)

Cable
A 1.8m or lower cable compliant with IEEEstd 1284 - 1994 or an
equivalent product
(use a shielded cable.)
Transmission mode
Compatible

				

Nibble
ECP
Interface level
Low level +0.0 to+0.4V

Interface signal
Signal

Function

name
1

Vbus

2

D-

For data transfer

3

D+

For data transfer

4

GND

Shell

Shield
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Basic specifications

Parallel interface specifications

High level +2.4 to +5.0V
Connector pin arrangement

Power (+5V)

Signal grand
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Pin No.

Signal name

Direction

1

nStrobe (HostClk)

TO PRINTER

This is parsing for reading data.
The data is read at the final edge.

Bi - direction

This is 8 - bit parallel data. High level is "1", while low - level is "0".

2
3
4
5
6
7
8
9

DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA

1
2
3
4
5
6
7
8

Function

Signal name

Direction

Function

36

nSelectIn
(IEEE1284 active)

TO PRINTER

Used in bidirectional communication.
It has to be in low - level when in
compatible mode.

Note!

• Inside the brackets is the nibble mode signal name.
• This only explains the compatible mode function.
• The IEEEstd1284 - 1994 nibble mode, stipulated by the US

Institute of Electrical and Electronics Engineers, is supported. If you use a computer or cable that does not meet
these regulations, unexpected operations may occur.

10

nAck (PtrClk)

FROM
PRINTER

This is a signal to display that data
receipt is finished.

11

Busy (PtrBusy)

FROM
PRINTER

This is a signal to display whether the
printer is in a state of receiving data.
Data cannot be received while in high
- level.

12

PError (AckDataReq)

FROM
PRINTER

A paper error is displayed in high level.

13

Select (Xflag)

FROM
PRINTER

If parallel interface is enabled, it will
always be high - level.

14

nAutoFd (HostBusy)

TO PRINTER

Bidirectional communication is used.

15

−

−

Not used.

16

GND

−

Signal grand

17

FG

−

Chassis ground

18

HILEVEL

FROM
PRINTER

19-30

GND

−

31

nInit (nInit)

TO PRINTER

At low - level, the printer will be
initialized.

32

nFault (nDataAvail)

FROM
PRINTER

The printer will go into low - level if
in an alarm state.

33

GND

−

34

−

−

35

HILEVEL

FROM
PRINTER
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Pin No.

Within the printer it is pulled up by
+5V at 3.3KΩ.
Signal grand

Signal grand
Not used.
Within the printer it is pulled up by
+5V at 3.3KΩ.

Font sample (PostScript3 emulation) (B840dn only)
Appendix

European font 136

Specifications
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Font sample (PCL emulation mode)
Appendix

Note!

Font No.

• Cannot be used in a Macintosh environment.

European font 91

Specifications

Note!

•The fonts that you can use may be limited depending on the OS.
•• OCR - A, OCR - B, and USPS POSTNET Bar Codes cannot be
used in a Windows environment.
•• Bitmap fonts have a fixed size.
•• Koufi, Naskh, and Ryadh printed out with PCL Font List cannot
be used.

Scalable fonts (87 font)
Font No.

Font No.

Bitmap font (3 fonts)
Font No.

USPS POSTNET Bar Codes
Font No.
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Font No.

 Print range and printing precision

• The printer precision is as follows: print positioning:±2mm; paper
skew: ±1mm/100mm; image stretch: ±1mm/100mm (for basis
weight 80g/m2 (ream weight of 70kg) ) .

Specifications

Note!

Appendix

The print range of the printer driver is as follows.
The actual print range may vary depending on the application.

• For double - sided printing the front - pack positioning precision is ±2.5mm.

A

6.35mm
F

6.35mm
6.35mm
D

B

C

6.35mm
E

Print Coverage
The range of print quality is
guaranteed. We recommend
that you print within this area
as possible.
Printable area
Printable range. Print quality
may be reduced.
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PostScript3 emulation mode
Units: mm

PCL emulation mode

Appendix
Specifications

A3

Width
A
297

Length
B
420

Top margin
C
4.23

Bottom margin
D
4.23

Left margin
E
4.23

Right margin
F
4.23

A4
A5

210
148

297
210

4.23
4.23

4.23
4.23

4.23
4.23

4.23
4.23

105
257
182
128
279.4
215.9
215.9
215.9
215.9
184.15
139.7
260
270
273
184
195
197
76~297
98.4
104.75
110
229

148
364
257
182
431.8
279.4
330.2
342.9
355.6
266.7
215.9
368
390
394
260
270
273
148~432
225.4
241.3
220
324

162
114
98.4

229
162
190.5

4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23

4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23

4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23

4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23
4.23

4.23
4.23
4.23

4.23
4.23
4.23

4.23
4.23
4.23

4.23
4.23
4.23

Paper size

A6
B4
B5
B6
Tabloid
Letter
Legal (13 inch)
Legal (13.5 inch)
Legal (14 inch)
Executive
Statement
8K (260 x 368mm)
8K (270 x 390mm)
8K (273 x 394mm)
16K (184 x 260mm)
16K (195 x 270mm)
16K (197 x 273mm)
Custom *1*2
Com - 9
Com - 10
DL
C4

C5
C6
Monarch
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*1: Letters 1 - 3 have width of 148
- 297mm, and length of 182 432mm.
*2: Multipurpose tray has width of
76 - 297mm, and length of 148
- 432mm.
*3: In PostScript3 emulation mode,
Letter (Free) is a fixed size (width
215.9mm and length 297mm).

 Character code table (PostScript3 Emulation Mode) (B840dn only)
• *
 ** - 83pv - RKSJ - H is mainly used for Macintosh. ("***" is the
font name)

Appendix

Note!

European character standard

•*
 ** - 90ms - RKSJ - H, *** - RKSJ - H, and *** - Ext - RKSJ - H
are mainly used for Windows. ("***" is the font name)

Specifications

•C
 haracters not in the printer character code table may not produce the expected results, such as not being output or becoming
garbled.
• I f printing using application software, the application software
may use it's own character code table.
•T
 he Japanese character code table is in a PDF file in a folder below "Software DVD - ROM".
Windows: [Misc] - [KanjiCode] folder.
Macintosh: [Kanji Code Table] folder.
• The printer font shown in each PDF file is as shown below.
File name
(Windows)
HG - 83pv.pdf

File name (Macintosh)
HeiseiKakuGo - W5 - 83pv -

HeiseiKakuGo - W5 - 83pv -

RKSJ.pdf

RKSJ - H

HG - 90ms.pdf HeiseiKakuGo - W5 - 90ms HGExRKSJ.pdf

Printer font name

HeiseiKakuGo - W5 - 90ms -

RKSJ.pdf

RKSJ - H

HeiseiKakuGo - W5 - Ext -

HeiseiKakuGo - W5 - Ext -

RKSJ.pdf

RKSJ - H

HG - RKSJ.pdf

HeiseiKakuGo - W5 - RKSJ.pdf

HeiseiKakuGo - W5 - RKSJ - H

HM - 83pv.pdf

HeiseiMin - W3 - 83pv - RKSJ.

HeiseiMin - W3 - 83pv - RKSJ

pdf

-H

HM - 90ms.pdf HeiseiMin - W3 - 90ms - RKSJ.
pdf
HMExRKSJ.pdf HeiseiMin - W3 - Ext - RKSJ.
HM - RKSJ.pdf

HeiseiMin - W3 - 90ms - RKSJ
-H
HeiseiMin - W3 - Ext - RKSJ -

pdf

H

HeiseiMin - W3 - RKSJ.pdf

HeiseiMin - W3 - RKSJ - H

211

Appendix

Symbol
Appendix
Specifications
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ZapfDingbats

Character code table (PCL emulation mode)
• If printing using application software, the application may use it's

Appendix

Note!

Standard European characters (PC - 8)

own character code table.
•T
 he Japanese character code table is in a PDF file in a folder below
"Software DVD - ROM".

Specifications

• Windows: [Misc] - [KanjiCode] folder
• The printer font shown in each PDF file is as shown below.
File name (Windows)

Printer font name

Heisei Kaku Go.pdf Heisei Kaku Gothic
Heisei Mincho.pdf

Heisei Mincho

Simple set
PC - 8
PC - 8 Dan/Nor
PC - 8 Grk
PC - 8 TK
PC - 775
PC - 850
PC - 851 Grk
PC - 852
PC - 855
PC - 857 TK
PC - 858
PC - 862 Heb
PC - 864 L/A
PC - 866
PC - 866 Ukr
PC - 869
PC - 1004
Pi Font
Plska Mazvia
PS Math
PS Text
Roman - 8
Roman - 9
Roman Ext
Serbo Croat1

Serbo Croat2
Spanish
Ukrainian
VN Int'l
VN Math
VN US
Win 3.0
Win 3.1 Arb
Win 3.1 L/G
Win 3.1 Blt
Win 3.1 Cyr
Win 3.1 Grk
Win 3.1 Heb
Win 3.1 L1
Win 3.1 L2
Win 3.1 L5
Wingdings
Dingbats MS
Symbol
OCR - A
OCR - B
OKI - OCRB
HP ZIP
USPSFIM
USPSSTP

USPSZIP
Arabic - 8
Bulgarian
CWI Hung
DeskTop
German
Greek - 437
Greek - 437 Cy
Greek - 737
Greek - 8
Greek - 928
Hebrew NC
Hebrew OC
Hebrew - 7
Hebrew - 8
IBM - 437
IBM - 850
IBM - 860
IBM - 863
IBM - 865
ISO Dutch
ISO L1
ISO L2
ISO L4
ISO L5

ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO
ISO

L6
L9
Swedish1
Swedish2
Swedish3
- 2 IRV
- 4 UK
- 6 ASC
- 10 S/F
- 11 Swe
- 14 JASC
- 15 Ita
- 16 Por
- 17 Spa
- 21 Ger
- 25 Fre
- 57 Chi
- 60 Nor
- 61 Nor
- 69 Fre
- 84 Por
- 85 Spa
- Cyr
- Grk
- Hebrew

Kamenicky
Legal
Math - 8
MC Text
MS Publish
PC Ext D/N
PC Ext US
PC Set1
PC Set2 D/N
PC Set2 US
WIN3.1J
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Symbol
Appendix
Specifications

214

Wingdings

List of Consumables and Options

Life Expectancy

Order No.

Toner cartridge

6,000 sheets

44707701

- The toner cartridge lowers its print quality 1 year or more
after they are unpacked.

Toner cartridge
(Large)

15,000 sheets

44708001

- Do not unpack consumables (toner cartridge, image drum)
before using them.

Image drum

30,000 sheets

Tray2

*1

Duplex Unit

44707401
44676104

*2

44676204

SD card (16GB)

44301003

Additional memory
(256MB)

44302203

Additional memory
(512MB)

44302207

-K
 eep consumables under an environment with temperature
0 to 35C and humidity 20 to 85%RH, and avoid direct sunlight.
-D
 o not keep consumables under an environment with high
or sharply changed temperature or humidity.
- Keep consumables away from babies and children.
• Consumables (image drum, toner cartridge) are not guaranteed.

*1 B
 840dn can be installed with two additional tray units, using
them as the its second/third trays.
*2 B840dn has a duplex unit installed as standard.

Note!

• For the storage method of paper, see "How to Keep Paper" (Setup
Instructions).
•N
 ote the following concerning the toner cartridge.
-U
 se genuine Oki Data original consumables to ensure optimum performance of the product.
When using a non genuine Oki Data original consumable, the
product may not deliver its optimum performance, and print
quality may decline.
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List of Consumables and Options

Product Name

Warranty doesn’t apply if the troubles arise with use of a non
genuine Oki Data original consumable. You need to pay for
repairs even during the warranty period. (Although not all non
genuine Oki Data original consumables cause a trouble when
used for the product.)

Appendix

Purchase the following consumables and options from the nearest
distributors.
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About Using Print Control Server
Appendix

Note!

About Using Print Control Server

Memo

• The details in this item may vary if you upgrade your Print Control
Server software.
• If the printer has been added to Print Control Server,
"JobAccounting:ON" will be printed on the printed menu map.

• The number of user IDs that can be registered and logs that canbe

saved with default settings
The number of user IDs that can be registered and logs that can
be saved with default settings are as follows. The number may
decrease depending on the contents of logs.
SD memory cards
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Number of user IDs that

Number of logs that can

can be registered

be saved

None

5000 ID

About 200 logs

Available

5000 ID

About 5000 logs

Setting up in Windows with a parallel connection
• A printer cable is not included. A bidirectional parallel cable compliant with IEEEstd1284 - 1994 is provided separately.

Installing a Printer Driver

Appendix

Note!

①①Set [parallel] on the printer control panel to [Enable].
②②Turn the printer power OFF.
③③Check that the parallel cable is removed from the computer.
Operating environment
Note!

• The details may differ from those given in this manual if you upgrade the version of printer driver you are using.

Windows 7/Windows 7 (64bit Version)
Windows Vista/Windows Vista (64bit Version)

④④Turn the computer power on.
⑤⑤Insert the Software DVD - ROM into the computer.
⑥⑥If [Run Automatically] is displayed, click [Run setup.exe].
If the [User Account Control] dialog box appears, click [Yes].
(For Windows Vista, click [Continue].)

⑦⑦Select the printer you are using, and click on [Next].

Windows Server 2008/Windows Server 2008 (64bit Version)
Windows XP/Windows XP (64bit Version)
Windows Server 2003/Windows Server 2003 (x64 Version)
Note!

•O
 peration cannot be done from MS - DOS and the Windows
command prompt/DOS prompt.

Memo

• I f you put the computer's BIOS setting to [ECP] mode, the data
transfer speed may increase. For the method of installation,
please inquire with the computer manufacturer.
• Please use a shielded parallel cable. (Maximum length 1.8m)

⑧⑧Read the [Software License Agreement] and click [I Agree].

Here Windows 7 will be used as an example. The screen or operating procedure may differ depending on the OS you are using.
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Setting up in Windows with a parallel connection

 Enabling Parallel Interface (P 92)

Appendix

⑨⑨Select [Easy Installation (Local)] below [Driver Installation].

⑬⑬If the [Installation Complete] screen is displayed, click [Close].
⑭⑭For Windows 8.1/Windows Server 2012 R2, select [Control

Appendix

Panel] - [Hardware and Sound] - [Devices and Printers].

For Windows 8/Windows Server 2012, select [Control Panel] [Hardware and Sound] - [Devices and Printers].

Setting up in Windows with a parallel connection

For Windows 7/Windows Server 2008 R2, select [Start] - [Devices and Printers].

Memo

•W
 ith [Easy Installation (Local)], all drivers supported by the
OS you are using are installed. If you want to manually select
the driver to install, select [Custom Installation (Printer)], and
follow the instructions on the screen.

⑩⑩[Next] Installation will start.
⑪⑪If the [Windows Security] dialog appears, click on [Install This

For Windows Vista/Windows Server 2008, select [Start] - [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers & Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

⑮⑮Right - click on the OKI B840 icon, select one menu item, and

check that all drivers installed are displayed in the sub - menu.

Driver Software].

For Windows XP/Windows Server 2003, if the [Install Hardware] dialog is displayed, click [Continue].

⑫⑫Connect the machine to the computer, and if a prompt is displayed instructing you to turn the machine's power on, connect the machine to the computer with a cable and turn the
power on for the machine.

In Windows Vista/Windows Server 2008/Windows XP/Windows
Server 2003, check that the icon for each driver is displayed.

⑯⑯Remove the software DVD - ROM from the computer.
		With this, setup is complete.
Follow the instructions displayed on the screen to complete
the installation.
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If setup is not going well

Occurrence

The interface is disabled.

 he printer driver print destination port is not correctly set up.
T
Check the settings using the following procedure.

Panel] - [Hardware and Sound] - [Devices and Printers].

For Windows 8/Windows Server 2012, select [Control Panel] [Hardware and Sound] - [Devices and Printers].
For Windows 7/Windows Server 2008 R2, select [Start] - [Devices and Printers].
For Windows Vista/Windows Server 2008, select [Start] - [Control Panel], and then click on [Printers].
For Windows XP, select [Start] - [Control Panel] - [Printers and
Other Hardware] - [Printers & Faxes].
For Windows Server 2003, select [Start] - [Printers & Faxes].

For the detailed procedure, refer to
Enabling a Parallel Interface (P 92).
The set up procedure was Follow the procedure in this chapter
incorrect.
and set up again from the beginning.
The parallel cable has
come out.

Plug the parallel cable in.

There is a problem with
the parallel cable.

If you have a spare parallel cable,
replace the other one with it.

Using a switch, buffer,
extension cable, etc.

Connect the printer directly to the
computer.

[Set Location to Search]
or [Set Location] is
displayed during setup.

Set it to the printer driver folder in
the Software DVD - ROM.

②②Right - click the printer icon and select [Properties] (in Win-

(In this example the DVD - ROM
drive is E:, and the printer driver is
PCL.)

dows 7 and later this is [Printer Properties]).

③③On the [Print Port] in the [Ports] tab, set the port to connect to
as shown below.

Setup was aborted.

If connecting with a parallel cable [LPT1]

E.g.: "E:\Drivers\ENU\PCL"

Follow the procedure and set up
again from the beginning.

• If you cannot setup with a parallel connection
Occurrence

Method of dealing with it

The computer does not
support bidirectional
parallel interfaces.

Use a computer that supports
bidirectional parallel interfaces.

The parallel cable may
not meet the standards.

Use a bidirectional parallel cable
compliant with IEEEstd1284 - 1994.

219

Setting up in Windows with a parallel connection

①①For Windows 8.1/Windows Server 2012 R2, select [Control

[Centro] is disabled in the detailed
settings. Set [Centro] in the printer
user menu to [Enabled].

Appendix

• If the printer icon has been created but you cannot print

Method of dealing with it

Appendix

If you are using UNIX or Linux

(B840dn)

Appendix

Use an LPD protocol

• Configure UNIX settings and print

If you are using UNIX or Linux (B840dn)

This explains how to print using a TCP/IP LPD protocol (lpr or lp
command). For details of the lpr and lp command, please refer to
the UNIX manual.

For Sun Solaris2.6 and 8
Note!

• You must have super - user rights.
•• The remote printer registration method using Admintool on
OpenWindows cannot be used on this printer, as the output
destination and queue name would be the same. Remote printers can be registered with the following method.
•• If Solaris 2.x's connection with the remote printer is stuck for
a long time, based on its system specifications it will consider
this to be an error, and will force disconnect. Therefore, if there
is a waiting time due to running out of paper while printing or
an online error, the printer will cut the connection.

• About LPD

LPD (Line Printer Daemon) is a protocol to print with a printer on
the network.
• About logical printers
This printer has three logical printers.

①①Log in as the UNIX administrator (root).

Logical printers

②②Register the printer's IP address and host name in the /etc/

lp

Function

If printing a PostScript or PCL format file

sjis

If printing a shift JIS Japanese character code text file

euc

If printing a euc Japanese character code text file

Note!

• sjis and euc are PostScript printer functions only.

hosts file.

			 192.168.0.2 ML

③③Check the connection using a ping command.
			 # ping ML

④④Register the print server.
The following explanation uses the environment shown below as an example.
Printer		

: B840dn

IP Address

: 192.168.0.2

MAC address

: 00:80:87:84:9C:9B

		# lpadmin -p ML_lp -m netstandard -o protocol=bsd -o
dest=ML:lp -v /dev/null
Note!

• The "lp" following ":" is a logical printer.
•• You may need to set the printer type or file content type depending on the file format you are printing. For details, please
refer to the manual that came with your OS.

⑤⑤Enable the print queue.
			 #/usr/sbin/accept ML_lp
			 #/usr/bin/enable ML_lp
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For HP - UX9.X and 10.X

⑥⑥Print.
		 # lp -d ML_lp<File Name>
• Use the following page if you do not need a banner page.

			

# lp -d ML_lp -o nobanner

			 # cancel ML_lp-<Job Number>

⑧⑧Check the print status.
# lpstat -p ML_lp
Note!

• This may not be correctly displayed depending on the UNIX
specifications.

•• HP - UX9.03 is used as an example.

①①Log in as the UNIX administrator (root) .
②②Register the printer's IP address and host name in the /etc/
hosts file.

			 192.168.0.2 ML

③③Check the connection using a ping command.
			 # ping ML

④④Configure the following settings if the remote spooller is not set
on the HP - UX machine you are using.
(1) Stop the printer spooler.

		

#/usr/lib/lpshut
(2) A
 dd the the following line to the /etc/inetd.conf file,
in order to register the remote spooler.

		
		

		

printer stream tcp nowait root
/usr/lib/rlpdaemon rlpdaemon -i
(3) Restart inetd.
#/etc/inetd -c

⑤⑤Configure the print queue settings.
			# /usr/lib/lpadmin -pML_lp -mrmodel -ormML -orplp
-ocmrcmodel -osmrsmodel -ob3 -v/dev/null
Note!

• Following "-p", "ML_lp" is the printer queue name; following
"-orm", "ML" is the host name; and following "-orp", "lp" is the
logical printer name.

⑥⑥Enable the print queue.
			 #/usr/lib/accept ML_lp
			 #/usr/bin/enable ML_lp
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If you are using UNIX or Linux (B840dn)

⑦⑦Delete a print request.

• You must have super - user rights.
Appendix

Note!

Note!

Appendix

⑦⑦Launch the printer spooler.
			 #/usr/lib/lpsched
Appendix

⑧⑧Start a print job.
			 # lp -d ML_lp<File Name>

If you are using UNIX or Linux (B840dn)

⑨⑨Delete a print request.
		 # cancel ML_lp-<Job Number>

⑩⑩Check the print status.
			 # lpstat -p ML_lp
Note!

• This may not be correctly displayed depending on the UNIX
specifications.

Use an FTP protocol
This explains how to print using a TCP/IP FTP protocol (ftp command).
For details on the ftp command, please refer to the UNIX manual.
•• About FTP

FTP (File Transfer Protocol) is a protocol for transferring files to the
host on a network.
•• About logical directories

This printer has three logical directories.
Logical printers

/lp

Function

If printing a PostScript or PCL format file

/sjis

If printing a shift JIS Japanese character code text file

/euc

If printing a euc Japanese character code text file

Note!

• sjis and euc are PostScript printer functions only.

The following explanation uses the environment shown below as an example.
Printer

: B840dn

IP Address

: 192.168.0.2

MAC address : 00:80:87:84:9C:9B
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• Start a print job.

Note!

• It is possible to print with any value put into Name and Password. However, if User is "root", then the Password is required.
The default value is the last 6 alphanumerical digits of the MAC address.

②②Move to transfer destination directory.
Note!

• Files cannot be transfered the root directory.

E.g. 2) If setting the print data with the absolute path "/users/
test/test.prn", and then transferring.
			 ftp> put /users/test/test.prn

⑤⑤Log out.
			 ftp> quit
Memo

• You can use the quote command's "stat" to check three states
- the client IP address, the login user name and the transfer
mode. Also, you can check the status of the printer by setting
a logical directory (lp, sjis, euc) after stat.

			 ftp> quote stat
			 211 - FTP server status:
			 Connected to: 192,168,0,3,5,112

ftp>cd /lp

250 Command OK.

			 User logged in: root

ftp>pwd

			 Transfer type: BINARY
			 Data connection: Closed.

257”/lp” is current directory.
ftp>

			 211 End of status.
			 ftp>

③③Set the transfer mode.
Note!

• There are two types of transfer mode, "BINARY Mode", which
outputs file details as they are, and "ASCII Mode", which
changes LF codes into CR+LF codes. If transferring files created with the printer driver, use "BINARY Mode"

			 ftp> quote stat /lp
			 211 - FTP directory status:
			 Ready
			 211 End of status.
			 ftp>

ftp> type binary

200 Type set to I.
ftp> type

Using binary mode to transfer files.
ftp>
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If you are using UNIX or Linux (B840dn)

#ftp 192.168.0.2
Connected to 192.168.0.2
220 EthernetBoard OkiLAN 9300e Ver 00.06 FTP Server.
User (192.168.0.2:none) :root
331 Password required.
Password
230 user Logged in.
Remote system type is FTP.
ftp>

E.g. 1) If transferring "test.prn" print data
			 ftp> put test.prn

Appendix

①①Log into the printer.

④④Start a print job.

Appendix

(MEMO)
Appendix
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